# Contents

## Chapter 1: Introduction

How to Use this Guide ................................................................. 1-1  
Chapter Summary ................................................................. 1-2

## Chapter 2: Getting Started

SageCRM Requirements ............................................................ 2-1  
  Licensing ........................................................................... 2-1  
  SageCRM Service Packs ...................................................... 2-1  
System Requirements ............................................................. 2-1  
  SageCRM ........................................................................... 2-2  
  Sage ERP Accpac ................................................................. 2-2  
  LanPak Licenses ................................................................. 2-3  
  Client Workstations ......................................................... 2-4  
Now You Can........................................................................ 2-4

## Chapter 3: SageCRM Installation

Installing SageCRM with Sage ERP Accpac Integration .................. 3-1  
Adding Sage ERP Accpac Accounting Integration after SageCRM is Installed ............. 3-5  
Now You Can........................................................................ 3-7

## Chapter 4: Configuring Servers and Server Access Permissions

Accessing Server Resources through a Browser .............................. 4-1  
Working with Internet Information Services Manager .................... 4-1  
  Restarting IIS to Reflect Security Changes .......................... 4-2  
  Checking the IIS Anonymous Access Account .................... 4-2  
Requirements for IIS 6.0 on Windows 2003 R2 .................................. 4-5  
  Configuring IIS for Sage ERP Accpac Integration ................... 4-5  
Setting Up SageCRM and Sage ERP Accpac on a Single Server ............. 4-7  
  Setting Directory Access Rights for NTFS ........................ 4-8  
  Allowing SageCRM to Connect to Sage ERP Accpac Data .......... 4-9  
  Setting Registry Permissions for the Internet Guest Account ....... 4-10
### Section 1: Setting Path Statements

- Disabling Connection Pooling If You Use COM/DCOM .................................................. 4-13
- Additional User Permissions for COM/DCOM (Single Server Setup) ............................... 4-14
  - MachineKeys Folder Permission .................................................................................. 4-15
  - Access and Launch Permissions .................................................................................. 4-16
  - Permission to Read the Registry on the SageCRM Server ........................................... 4-19

### Section 2: Setting up SageCRM and Sage ERP Accpac on Separate Servers

- Setting Up the IIS Anonymous Access Account .............................................................. 4-21
- Setting Up Sage ERP Accpac Workstation and Integration on the SageCRM Server .......... 4-23
- Setting Up the ISAPI Redirector and Virtual Directories .................................................... 4-24
  - Setting Up the ISAPI Redirector .................................................................................. 4-24
  - Editing Accpac_Session.js ......................................................................................... 4-25
  - Creating a Virtual Directory for the ISAPI Redirector on the SageCRM Server ............ 4-26
  - Creating and Setting Up a Virtual Directory for ERP Static Content on the SageCRM Server .................................................................................................................... 4-26

### Section 3: Additional User Permissions for COM/DCOM (Single Server Setup)

- Permission to Read the Registry on the SageCRM Server ........................................... 4-19

### Section 4: Additional User Permissions for COM/DCOM (Separate Server Setup)

- Other Settings ............................................................................................................. 4-30

### Section 5: Running SageCRM Integrated with Sage ERP Accpac on Windows 2008 Server

- Setting Up IIS Role Services and Parent Paths .................................................................. 4-32
- Setting the IIS 7 Impersonated User ................................................................................ 4-33
- Setting IIS Feature Permissions to Execute ....................................................................... 4-33
- Running Internet Explorer as an Administrator ................................................................ 4-34
- Using Regacc to Register Sage ERP Accpac Screens ..................................................... 4-34
- Running .NET Remoting Service under the Local Administrator Account ..................... 4-34
- Running SageCRM on Windows 2008 Server as a Non-Administrative User ................... 4-35

### Chapter 5: Sage ERP Accpac Integration (E/W) Component

- Overview of Steps .......................................................................................................... 5-1
- Installing the E/W Integration Component ....................................................................... 5-2
- Activating SageCRM Integration within Sage ERP Accpac ............................................. 5-5
- Selecting Integration and Notification Options ............................................................... 5-6
- Setting Up Sage ERP Accpac Workstations .................................................................... 5-8

### Chapter 6: Setting Up Sage ERP Accpac Integration in SageCRM

- Logging On to SageCRM ................................................................................................. 6-1
- Selecting Integration Settings ......................................................................................... 6-2
Synchronizing Tables ................................................................. 6-3
Resetting Currency in New Installations ................................. 6-4
  Currency Troubleshooting ....................................................... 6-5
Importing Customer, Vendor, and National Account Relationships from Sage ERP Accpac ................................................................. 6-6
Converting Existing Sage ERP Accpac O/E Quotes and Orders ................................................................. 6-8
  Conditions for Successful Conversion ........................................ 6-9
Setting Up Sage ERP Accpac Security ........................................ 6-10
  Setting Up Sage ERP Accpac User-Level Security ........................................ 6-11
  Setting Up Sage ERP Accpac Database-Level Security ........................................ 6-12
  Setting Up User-Level Security on the SageCRM User Record ........................................ 6-13
Now You Can............................................................................ 6-14

Chapter 7: Using SageCRM for Sage ERP Accpac

Overview .................................................................................. 7-1
Integration Changes to SageCRM Screens ....................................... 7-1
  SageCRM Tabs and Screens Added During Integration ........................................ 7-2
  Changes to Existing SageCRM Screens ........................................................................ 7-5
Viewing Company and Opportunity Information ............................... 7-6
  Logging On to SageCRM .................................................................... 7-6
  Specifying the Number of Rows that Appear in the Grid ........................................ 7-6
Viewing and Modifying Company Information ....................................... 7-7
  Viewing Company Tabs .................................................................... 7-7
  Specifying Sage ERP Accpac A/R and A/P Person and Address Types ........................................ 7-8
  Viewing and Modifying Optional Fields ........................................................................ 7-9
  Viewing Customer and Vendor Aging and Statistical Information ........................................ 7-10
Viewing and Modifying Opportunity Information ............................... 7-12
  Viewing Opportunity Tabs .................................................................... 7-12
  Viewing and Modifying Opportunity Stage and Status ........................................ 7-12
  Viewing Opportunity Forecast and Totals ........................................................................ 7-14
Importing National Accounts ......................................................... 7-15
Changing Customer and Vendor Numbers ......................................... 7-16
Promoting a Customer or Vendor to Sage ERP Accpac ............................... 7-16
  Promoting a Company .................................................................... 7-16
  Changing a Customer or Vendor Link ........................................................................ 7-18
Creating and Working with O/E Quotes and Orders ............................... 7-18
  Creating a New Quote .................................................................... 7-19
  Viewing and Editing Existing Quotes ........................................................................ 7-22
  Promoting Quotes to an Order .................................................................... 7-23
  Creating a New Order .................................................................... 7-25
  Viewing and Editing Existing Orders ........................................................................ 7-29
Using Sage ERP Accpac Inquiry .......................................................... 7-29
Order Entry (O/E) Inquiry ............................................................... 7-30
    Viewing, Modifying, or Creating Order Entry Transactions ............. 7-30
    Creating a New Sales Order ........................................................ 7-37
    Viewing Credit/Debit Notes ...................................................... 7-38
    Viewing All Shipments ............................................................. 7-39
    Viewing Pending Shipments ..................................................... 7-39
    Viewing Item Sales History ..................................................... 7-41
    Viewing Customer Price List ................................................... 7-42
    Viewing Serial and Lot Number Sales History ............................... 7-43
Purchase Orders (P/O) Inquiry ....................................................... 7-44
    Creating a New Purchase Order .................................................. 7-44
    Viewing Credit/Debit Notes ...................................................... 7-45
    Viewing All Receipts ............................................................... 7-46
    Viewing Pending Receipts ....................................................... 7-46
    Viewing Purchase History ....................................................... 7-48
    Viewing Vendor Contract Costs ............................................... 7-49
    Viewing Serial and Lot Number Purchase History .......................... 7-50
    Viewing or Editing Requisitions ............................................... 7-51
    Viewing or Editing Returns ..................................................... 7-52
Accounts Receivable (A/R) and Accounts Payable (A/P) Inquiry ............ 7-54
    Viewing Posted Transactions .................................................... 7-54
    Viewing Unposted Invoices ..................................................... 7-55
    Viewing Unposted Receipts ..................................................... 7-56
    Viewing Unposted Refunds ..................................................... 7-57
Project and Job Costing (P/M) Inquiry ........................................... 7-58
    Creating a New Contract .......................................................... 7-58
    Viewing and Editing Contracts ............................................... 7-59
    Viewing Contract Transaction History ....................................... 7-61
Return Material Authorization (R/A) Inquiry .................................... 7-63
    Creating a New Return Authorization ........................................ 7-63
    Viewing or Editing Return Authorizations .................................. 7-64
Solo Integration with SageCRM ..................................................... 7-65
    Notes on Using Solo client with SageCRM ................................ 7-65
Now You Can................................................................. 7-66
Chapter 1
Introduction

Sage ERP Accpac Accounting Integration for SageCRM creates a link that enables SageCRM and Sage ERP Accpac to share information as it is entered into either program.

After integration, front-office personnel can create customer quotes and orders in SageCRM and then promote those quotes and orders to Sage ERP Accpac. As quotes and orders are processed, both systems are updated, preventing redundant data entry and enabling front-office and back-office personnel to view information that is current and correct.

This guide describes how to:

- Install SageCRM 7.0
- Integrate SageCRM 7.0 with Sage ERP Accpac ERP 5.6 or 6.0
- Use SageCRM features that are added during integration

How to Use this Guide

The first six chapters of this guide are for SageCRM implementers. Chapter 7, “Using SageCRM for Sage ERP Accpac,” is for SageCRM users.

We assume that implementers:

- Have experience implementing and troubleshooting SageCRM installations.
- Understand Sage ERP Accpac installation and setup.
- Have experience working with Sage ERP Accpac.

We assume that users are familiar with web browser software and have experience working with Sage ERP Accpac.

**Note:** SageCRM 7.0 can be integrated with Sage ERP Accpac versions 5.6 or 6.0.
Chapter Summary

The table below gives a summary of each chapter in this guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>2: Getting Started</td>
<td>Requirements for installing SageCRM and integrating it with Sage ERP Accpac.</td>
</tr>
<tr>
<td>3: SageCRM Installation</td>
<td>How to install SageCRM with the SageCRM integration component.</td>
</tr>
<tr>
<td>4: Configuring Server Access Permissions</td>
<td>How to configure the SageCRM and Sage ERP Accpac servers for Sage ERP Accpac integration.</td>
</tr>
<tr>
<td>5: Sage ERP Accpac Integration (E/W) Component</td>
<td>How to install the Sage ERP Accpac integration component.</td>
</tr>
<tr>
<td>6: Using SageCRM for Sage ERP Accpac</td>
<td>How to work with SageCRM and perform Sage ERP Accpac administration tasks.</td>
</tr>
<tr>
<td>7: Where to Now</td>
<td>Where to find more information on working with SageCRM.</td>
</tr>
</tbody>
</table>
Chapter 2
Getting Started

In this chapter you will learn about:

- SageCRM requirements.
- System requirements for the SageCRM server, Sage ERP Accpac server, and SageCRM workstations.

SageCRM Requirements

Licensing

Before you install SageCRM, ensure that your SageCRM license includes Sage ERP Accpac Integration.

SageCRM Service Packs

To integrate SageCRM 7.0 with Sage ERP Accpac 6.0, you must be running SageCRM 7.0 Service Pack 1.

If you are performing a new installation of SageCRM from the Sage ERP Accpac 6.0 DVD, this service pack is included in the software. If you are integrating an existing installation of SageCRM 7.0 with Sage ERP Accpac 6.0, you must install SageCRM 7.0 Service Pack 1.

To download the service pack, contact your local Sage support center or your Business Partner.

If you are a Sage Business Partner, you can download the service pack from the Sage Partner Portal at www.sagepartnerportal.com.

If you are a member of the SageCRM Developer Program, you can download the service pack from the SageCRM Community website at https://community.sagecrm.com.

System Requirements

This section lists the recommended minimum software and hardware requirements for running SageCRM and Sage ERP Accpac. For more
information on recommended server specifications, refer to the SageCRM Technical Specification and the SageCRM System Administration Guide.

If you are using Windows 2008, refer to the section “Running SageCRM Integrated with Sage ERP Accpac on Windows 2008” in Chapter 4.

**SageCRM**

- Windows Server 2003 R2 or 2008 with the latest service packs. Note that SageCRM supports Windows Vista and Windows 7 only as client operating systems.

- Microsoft SQL Server 2005 or 2008 with the latest service packs. Note that SageCRM does not support binary or case-sensitive collation, so the SQL server must be set up with case-insensitive collation.

- Microsoft Internet Information Server (IIS) 6.0 or 7.0 with the latest patches.

**Sage ERP Accpac**

Refer to your Sage ERP Accpac documentation for a complete list of Sage ERP Accpac system requirements. For Sage ERP Accpac integration with SageCRM, you must install the following components on a server:

- Compatible database software. For details, refer to the Sage ERP Accpac Installation and System Administrator’s Guide.

- Sage ERP Accpac 5.6 or 6.0 with the following programs:
  - System Manager
  - General Ledger
  - Accounts Receivable
  - Accounts Payable
  - Order Entry
  - Inventory Control

  **Note:** If you are integrating SageCRM with Sage ERP Accpac 6.0, you must select the Portal option when installing Sage ERP Accpac.

- Sage ERP Accpac Web Deployment. Note that “web deployment” does not refer to setting up the Sage ERP Accpac Portal, but instead refers to the process of deploying Sage ERP Accpac on a web server to support remote Web Client access.
For instructions on web deployment, see the *Sage ERP Accpac Installation and System Administrator’s Guide* and the “Selecting Integration and Notification Options” section in Chapter 5 of this guide.

**Notes:**

- Before integrating SageCRM with Sage ERP Accpac 5.6 or 6.0, you must install the latest System Manager and application product updates.
- All Sage ERP Accpac programs that you integrate with SageCRM must be from a single version of Sage ERP Accpac (either 5.6 or 6.0).
- SageCRM also integrates with the following Sage ERP Accpac programs:
  - Purchase Orders (5.6A and 6.0)
  - Return Material Authorization (5.6A and 6.0)
  - Project and Job Costing (5.6A and 6.0)
- SageCRM also integrates with optional fields if you use Sage ERP Accpac Transaction Analysis and Optional Field Creator.

**LanPak Licenses**

You do **not** need a Sage ERP Accpac LanPak license to view and use the Sage ERP Accpac integrated features that appear on SageCRM screens. For example, you can:

- View opportunity status details and current totals (Quote Amount, Pending Amount, Order Amount, Shipment Amount, and Invoice Amount) on the Opportunity Summary screen.
- Create a new quote or order from the Company Summary screen.
- Use the Quotes screen to create new quotes, promote quotes to orders, or view a summary of quotes for an opportunity.
- Use the Orders screen to create new orders or view a summary of orders for an opportunity.
- Use the Sage ERP Accpac Inquiry screens described in the “Using Sage ERP Accpac Inquiry Features” section of this chapter, such as P/O Inquiry and R/A Inquiry.

You **do** need a LanPak license to use any SageCRM feature that opens a Sage ERP Accpac form. For example, the A/R Inquiry and O/E Inquiry screens include buttons and links that open Sage ERP Accpac forms.
If you are upgrading to SageCRM 7.0, make sure that you install enough LanPak licenses to support SageCRM access to Sage ERP Accpac forms.

**Client Workstations**

To set up a workstation that allows SageCRM users to open Sage ERP Accpac forms, you must either install Sage ERP Accpac on that workstation or set up access to the Sage ERP Accpac Web Client.

*Note:* The Web Client is *not* the Sage ERP Accpac Portal. It is software that enables remote access to Sage ERP Accpac deployed on a web server.

After setting up Web Client access, you must run Sage ERP Accpac at least once per workstation before starting to work with SageCRM.

The first time you use a browser to connect to a Sage ERP Accpac company database, you will be prompted to download Web Client Setup files. For more information, refer to your Sage ERP Accpac documentation.

In addition to the requirements listed in Chapter 3 of the *SageCRM System Administrator Guide*, workstations must meet the following minimum requirements for integration with Sage ERP Accpac:

- **Windows XP or newer.** If you are using Windows Vista or Windows 7 on the client workstation or Windows 2008 on the server and you need to open Sage ERP Accpac forms from SageCRM, you must run Internet Explorer as an administrator. For instructions, refer to the section “Running Internet Explorer as an Administrator” in Chapter 4.

- **Microsoft Internet Explorer 7.0 or newer.** Note that you must apply the following security settings:
  - Download signed ActiveX controls
  - Run ActiveX controls and plugins
  - Script ActiveX controls marked as safe
  - Active scripting

**Now You Can...**

- Explain SageCRM licensing requirements.
- List system requirements for the SageCRM server, Sage ERP Accpac server, and Sage ERP Accpac workstations.
Chapter 3
SageCRM Installation

In this chapter, you will learn:

- How to install SageCRM for Sage ERP Accpac integration.
- How to install Sage ERP Accpac Accounting Integration for SageCRM after SageCRM is installed.

Sage ERP Accpac Accounting Integration for SageCRM adds components to SageCRM so it can integrate with Sage ERP Accpac accounting programs.

After the installation described in this chapter, you must add integration components to Sage ERP Accpac, so it can integrate with SageCRM, as described in Chapter 5.

You must also configure servers and service access permissions as described in Chapter 4.

Installing SageCRM with Sage ERP Accpac Integration

This section describes the procedure for a new installation of SageCRM with Sage ERP Accpac integration.

If you are upgrading from a previous version of SageCRM, refer instead to the SageCRM Integration Update Notice that is provided with your update package.

The instructions that follow are for SageCRM 7.0 integrated with Sage ERP Accpac 6.0, where the installation is from the Sage ERP Accpac 6.0 DVD. If you are installing SageCRM 7.0 integrated with Sage ERP Accpac 6.0 from a SageCRM DVD, alternate instructions are noted in the following procedure.

You should also refer to the instructions in Chapter 5 of the SageCRM System Administrator Guide.

To install SageCRM with Sage ERP Accpac Integration:

9. Insert the installation DVD.
10. Select software to install.
• If you are installing from a Sage ERP Accpac 6.0 DVD, select **Install SageCRM 200.**

• If you are installing from a SageCRM 7.0 DVD, select **SageCRM for Sage ERP Accpac**, and then select **SageCRM 7.0 for Sage ERP Accpac.**

11. Click **Next.**

12. In the License Agreement dialog box, review the License Agreement carefully.

• If you accept all of the terms, select **I accept the terms of the license agreement** and then click **Next** to continue.

• If you do not accept the terms, click **Cancel** to end the installation.

13. In the User Details dialog box, type your name, company name, and license key. Your company name and license key must match the information provided to you by Sage, with identical capitalization, spacing, and punctuation.

14. Click **Next.**

15. Select your database type (the default selection is **Existing Microsoft SQL Server**).

   **Note:** If SageCRM does not find the required Microsoft SQL Server or Client Tools installed, a dialog box appears that prompts you to install Microsoft SQL Server Express. You can install it or click **Next** to proceed to Step 9.

16. Click **Next.**

17. If you entered a license key that includes integration with Sage ERP Accpac, the Sage ERP Accpac Integration dialog box appears. Select the version of Sage ERP Accpac that you are integrating with SageCRM.

• If you are installing SageCRM 7.0, you can select **v6.0** or **v5.6.**

• If you want to install Sage ERP Accpac Integration later, select **I will install the Sage ERP Accpac Integration later.** You can install the accounting integration component using a separate installation choice on the Sage ERP Accpac Integration ERP installation screen, as described in the next section, “Adding Sage ERP Accpac Accounting Integration after SageCRM is Installed.”

18. Click **Next.**

19. In the Installation Name dialog box, type a name for the installation. We recommend that you use the default installation name **CRM.**
20. Click **Next**.

21. In the Choose Destination Location dialog box, specify the location for the Web Root Files. This becomes the default location for the SageCRM program files.

   **Note:** We recommend that you use the default location `\Program Files\Sage\CRM`. IIS searches for the SageCRM home page in this location.

22. Click **Next**.

23. In the SQL Database Server Login dialog box, confirm your server name and user ID, and enter the password for this user ID.

24. Click **Next**.

25. In the Select Setup Type dialog box, select the **No demo data** check box.

26. Click **Next**.

   Depending on your license options, the Select Install Add Ons dialog box may appear.

27. If you want to install a sample site, select **Sample Self Service support site**.

28. Click **Next**.

29. In the Default Currency dialog box, select a currency.

   **Note:** You can change your currency selection later when you reset the base currency in SageCRM after performing the Synch Dropdowns administration task described in Chapter 6: “Using SageCRM for Sage ERP Accpac.”

30. Click **Next**.

31. To convert SageCRM reports to PDF format, you must install FOP PDF conversion software developed by Apache Software Foundation ([http://www.apache.org](http://www.apache.org)).

   - If the software is already installed, go to the next step.

   - If the software is not installed, the Install PDF Conversion Software dialog box appears. Select **Yes, Install this software**, and then click **Next**.
     
     The Start Copying Files dialog box appears.

32. Review your settings, and then click **Next**.
SageCRM installation begins.

33. The FOP PDF conversion software requires the Java Runtime Engine (version 1.4 or newer).
   - If you have the Java Runtime Engine installed, go to the next step.
   - If you do not have the Java Runtime Engine installed, you are prompted to install it during the SageCRM installation. To install the software, click **OK** and follow the on-screen instructions.

**Note:** If the Java Runtime Engine installer prompts you to restart your computer, click **No** so that you can complete the SageCRM installation before restarting.

When the Java Runtime Engine installation is complete, SageCRM installation continues.

When the SageCRM installation is complete, the Setup Complete dialog box appears, giving you an option to launch SageCRM and a Readme file.

34. To complete the installation, click **Finish**.

Depending on what you selected, the Readme file may appear in one browser window, and the SageCRM logon page may appear in another browser window.

If you were prompted to restart your computer during the Java Runtime Engine installation, restart your computer now.

You can log on to SageCRM (use the user name **Admin** with no password). However, you will not be able to access Sage ERP Accpac information until you follow the steps outlined in the next chapter, “Configuring Servers and Server Access Permissions.”

**Note:** The default installation location for SageCRM is C:\Program Files\Sage\CRM\CRMInstallName.

After you have installed SageCRM, you must install the Sage ERP Accpac integration (E/W) component, which enables Sage ERP Accpac to send information to SageCRM. For instructions, refer to Chapter 5: “Sage ERP Accpac Integration (E/W) Component.”

**Note:** You can set up servers and server access permissions before or after installing the Sage ERP Accpac integration (E/W) component.
Adding Sage ERP Accpac Accounting Integration after SageCRM is Installed

You can install Sage ERP Accpac Accounting Integration for SageCRM after installing SageCRM. The two most common reasons for adding Sage ERP Accpac Accounting Integration after installing SageCRM are these:

- If SageCRM is already integrated with Sage ERP Accpac and you upgrade Sage ERP Accpac to a newer version, you must reinstall Sage ERP Accpac Integration and select the newer version of Sage ERP Accpac.
- If you installed SageCRM but did not install accounting integration, you must follow this procedure to add Sage ERP Accpac.

Note: The version of the Sage ERP Accpac Integration must match the version of SageCRM that you are running. For example, you cannot add Sage ERP Accpac Accounting Integration for SageCRM 7.0 to a previous version of SageCRM.

The instructions that follow are for SageCRM 7.0 integrated with Sage ERP Accpac 6.0, where the installation is from the Sage ERP Accpac 6.0 DVD. If you are installing SageCRM 7.0 integrated with Sage ERP Accpac 6.0 from a SageCRM 7.0 DVD, alternate instructions are noted in the following procedure.

Note: SageCRM 7.0 does not integrate with Sage ERP Accpac version 5.5 or earlier.

To install Sage ERP Accpac Accounting Integration for SageCRM after SageCRM is installed:

1. Insert the installation DVD.
2. Select software to install.
   - If you are installing from a Sage ERP Accpac 6.0 DVD, select SageCRM for Sage ERP Accpac, and then select Sage ERP Accpac Accounting Integration for SageCRM.
   - If you are installing from a SageCRM 7.0 DVD, select Install Sage ERP Accpac Accounting Integration, and then select Install Integration Component for SageCRM.
3. Click Next.
   The Integration Component for SageCRM 7.0 dialog box appears.
4. Click Next.
5. Select a SageCRM install to integrate with Sage ERP Accpac.
   Click **Next**.

6. Select an installation or upgrade option.

   - If your previous SageCRM install was not integrated with Sage ERP Accpac, select **Install Sage ERP Accpac Integration**.
   - If you have upgraded your Sage ERP Accpac version since you installed Sage ERP Accpac Integration for SageCRM 7.0, select **Upgrade your existing Sage ERP Accpac Integration**.

      For example, select this option if you are moving from SageCRM 7.0 with Sage ERP Accpac 5.6 to SageCRM 7.0 with Sage ERP Accpac 6.0.

7. Click **Next**.

8. Select a Sage ERP Accpac version or upgrade path.

   - If you selected **Install Sage ERP Accpac Integration** in the previous step, select a Sage ERP Accpac version to integrate with SageCRM.
   - If you selected **Upgrade your existing Sage ERP Accpac Integration** in the previous step, select the appropriate upgrade path. For example, select **5.6 → 6.0** if you are upgrading from SageCRM 7.0 with Sage ERP Accpac 5.6 to SageCRM 7.0 with Sage ERP Accpac 6.0.

9. Click **Next**.

10. In the SQL Database Server Login details dialog box, confirm your server name and your SQL Server user ID, and enter the password for this user ID.

11. Click **Next**.

    The Sage ERP Accpac Integration installation begins.

12. If you are prompted to stop IIS, click **Yes**.

    **Note:** IIS restarts automatically near the end of the installation process.

    When the installation is complete, the Setup Complete dialog box appears.

13. To complete the installation process, click **Finish**.

    If you did not clear the **Launch Now** check box, the SageCRM logon page appears in a browser window.
If you are upgrading from a previous version, you may need to perform the following tasks after installing the upgrade:

- Reset IIS settings. For details, see Chapter 4.
- Re-synchronize tables. For details, see “Synchronizing Tables” in Chapter 5.

**Now You Can...**

- Install SageCRM for Sage ERP Accpac.
- Install Sage ERP Accpac Accounting integration after SageCRM is installed.
Chapter 4
Configuring Servers and Server Access Permissions

In this chapter you will learn:

- How server resources are accessed through a browser.
- How to work with Microsoft Internet Information Services (IIS).
- How to configure servers and server access if SageCRM and Sage ERP Accpac are installed on a single server.
- How to configure servers and server access if SageCRM and Sage ERP Accpac are installed on different servers.

Accessing Server Resources through a Browser

Using the Internet Guest Account

When you access resources on a server through a browser, you do not access these resources through the user account you used to log on to the computer. By default, you access resources on the server as the default user created when you installed Internet Information Services (IIS). This account is called the Internet Guest Account.

The short name of this account is IUSR_Computer Name. For example, if the machine name of your computer is SERVERA, the Internet Guest Account user account that is automatically created by IIS would be IUSR_SERVERA.

To enable integration between SageCRM and Sage ERP Accpac, you must authorize the Internet Guest Account to access resources on the server.

These permissions/rights are a combination of directory access rights (for the NTFS file system) and setting rights to the server’s registry.

Working with Internet Information Services Manager

This section is an overview of how to work with Microsoft Internet Information Services (IIS) Manager. For information on installing IIS, refer to the Sage ERP Accpac Installation and System Administrator’s Guide.
Unless otherwise specified, instructions and figures in this section are based on Windows 2003 R2. See also the section, “Requirements for IIS 6.0 on Windows 2003 R2,” later in this chapter.

For more in-depth information, refer to the Internet Services Manager’s online help.

**Note:** Log on with Administrator rights to the server where SageCRM is installed.

**To start the Internet Services Manager:**

- On the Windows taskbar, click **Start > Settings > Control Panel > Administrative Tools > Internet Information Services Manager.**

### Restarting IIS to Reflect Security Changes

Whenever you change security settings on the server, you need to restart IIS to apply your changes.

**To stop and restart IIS:**

1. In Internet Information Services Manager, right-click the server name, and then select **All Tasks > Restart IIS.**

2. Click **Restart** to restart IIS.

IIS applies any security changes you made to the system.

### Checking the IIS Anonymous Access Account

The IIS Anonymous Access account is the user account used by IIS to access resources on the server. The IIS Anonymous Access account can be set either at the Default Website properties level or individually for each website that is running within IIS.
To check the settings for the SageCRM installation:

1. In Internet Information Services Manager, double-click the server name to expand the tree view.

2. Click Default Website.

3. Right-click the SageCRM installation, and then select Properties.

4. Click the Directory Security tab:

5. In the Anonymous Access and Authentication Control section, click Edit.

The Authentication Methods form appears:

The User name field displays the name of the account with which IIS will log onto the server on this form. By default, this is the default Internet Guest Account created by IIS during installation.
6. Make sure the **Enable Anonymous Access** option is selected.

7. Click **OK** to save any changes you made, or click **Cancel** to exit without saving your changes.

8. If you made changes, restart IIS to apply them.

The following sections in this chapter describe security permissions that must be assigned to the Internet Guest Account.

---

**Note:** Before you assign security permissions to the Internet Guest Account, consider the following points.

- The preceding section describes how to view website settings for the SageCRM website. You can also view the Default website properties by selecting the Default Website node under the computer name. From the shortcut menu, select Properties to display the default settings for all websites. These defaults can, however, be overwritten at the individual website level.

- If you prefer, you can create a separate account from the default Internet Guest Account created by IIS for use by the SageCRM website. This may be preferable if you are running more than one website on this server.

---

**To create an account for the SageCRM website:**

1. In Computer Management / Local Users and Groups, create a new user, such as CRM. This user must have the following rights:

   - Administrative rights on the SageCRM server, as described in the sections "Setting Up SageCRM and Sage ERP Accpac on a Single Server" and "Setting up SageCRM and Sage ERP Accpac on Separate Servers"

   - Rights to the SageCRM installation and data

   - Rights to Sage ERP Accpac installation and data

   - Rights to read the registry on the SageCRM server. If you need to access resources across a network (for example, if your database is on a different server), this would be a domain user.

2. On the Anonymous User Account setup form, click **Browse** and then select the new user you created.

   If you change the password for this account, you will also need to change it on the Anonymous User Account setup form.

---

**Important:** Make sure that you apply the security settings in the rest of this chapter to this new login account, and not to the default Internet Guest Account.
Requirements for IIS 6.0 on Windows 2003 R2

This section describes configuration requirements for Microsoft Internet Services Manager (IIS 6.0) on Windows 2003 R2. For more in-depth information, refer to the Internet Information Services Manager’s online help.

If you are configuring IIS 7.0 to work with SageCRM, see the section “Running SageCRM Integrated with Sage ERP Accpac on Windows 2008” in this chapter.

Configuring IIS for Sage ERP Accpac Integration

To set up IIS for SageCRM, start by following the setup directions in the SageCRM System Administrator Guide.

To set up IIS to work with Sage ERP Accpac integration, you must open IIS Manager and perform further configuration to allow Active Server Pages and enable parent paths and buffering.

Note: Log on with Administrator rights to the server where SageCRM is installed.

To open IIS Manager:

1. Log on with Administrator rights to the server where SageCRM is installed.

2. On the Windows taskbar, click Start > Settings > Control Panel > Administrative Tools > Internet Information Services Manager.

In addition to allowing All Unknown ISAPI Extensions as described in the SageCRM Technical Specification, you should also allow Active Server Pages in Web Service Extensions.

To allow Active Server Pages in Web Service Extensions:

1. Open IIS Manager.

2. Double-click the SageCRM server.

3. Click the Web Service Extensions folder.

4. In the right pane, right-click Active Server Pages, and then click Allow.

The Status for Active Server Pages changes to Allowed.
To enable parent paths and buffering:

1. Open IIS Manager.
2. Double-click the SageCRM server.
3. Right-click the **Websites** folder, and then select **Properties**.
4. Click the **Home Directory** tab.
5. Click the **Configuration** button.
6. On the Application Configuration form, click the **Options** tab.
7. Select the following options:
   - **Enable buffering**
   - **Enable parent paths**
8. Click **OK** to close the Application Configuration form.

9. Click **OK** to close the Properties form.

10. Restart IIS.

**Setting Up SageCRM and Sage ERP Accpac on a Single Server**

This section describes how to configure server access if you have installed SageCRM and the Sage ERP Accpac server on a single server. For instructions on how to configure server access if you have installed SageCRM and the Sage ERP Accpac server on separate servers, see the next section in this chapter, “Setting up SageCRM and Sage ERP Accpac on Separate Servers.”

Unless otherwise specified, the procedures and examples in this section are based on Windows 2003 R2.

The following is a summary of the steps for setting up SageCRM and Sage ERP Accpac on a single server after you install Sage ERP Accpac and SageCRM as described in Chapter 3.

**To set up SageCRM and Sage ERP Accpac on a single server:**

1. Configure access permissions for the IIS Anonymous Access Account (Internet Guest Account), as described in this chapter.

2. Install and set up the Sage ERP Accpac Integration (E/W) Component. For details, see Chapter 5.

3. In SageCRM, set up Sage ERP Accpac integration, using the Sage Accpac Administration option on the SageCRM Administration menu.
4. If you are integrating SageCRM with Sage ERP Accpac 5.6 and using the COM/DCOM connection method, configure additional permissions for Windows users who may be updating SageCRM from Sage ERP Accpac. For more information, see the section, “Additional User Permissions for COM/DCOM (Single Server Setup)” in this chapter.

In the subsections to follow, you set specific rights for your IIS Anonymous User. It is recommended this user have administrative rights on the SageCRM server.

**Setting Directory Access Rights for NTFS**

You must perform the tasks in this section if you are using the NTFS file system. If you are using a different file system (such as FAT32), proceed to the next section.

SageCRM requires the following directory security rights to be set for the Internet Guest Account:

- SageCRM installation directory requires full access.
- Sage ERP Accpac Shared Data directory requires full access.

**To set security rights for the SageCRM installation directory:**

1. In Windows Explorer, navigate to C:\Program Files\Sage\CRM\<CRMInstallName>.

   **Note:** This example assumes that SageCRM is installed in C:\Program Files\Sage\CRM\<CRMInstallName>.

   If you specified another location during the SageCRM installation, use it in place of \Sage\CRM.

2. Right-click the EWARE.CSS file, and then click **Properties**.
3. Click the **Security** tab.
4. Click the **Add** button.
5. Select the Internet Guest Account (IUSR_<ComputerName>).
6. Click **OK**.

   The Internet Guest User account is added to the list of user accounts that have rights to this directory.
7. Click **OK** to save the changes.

8. On the **Security** tab of the Properties form, select the Internet Guest Account.

9. Select the **Allow** option for the Full Control permission. (Full Control automatically selects all the other permissions, except Special Permissions.)

10. Click **OK**.

11. Repeat steps 1 to 10 to set Read and Write access for the `C:\Program Files\Sage\CRM\<CRMInstallName>` folder.

**Allowing SageCRM to Connect to Sage ERP Accpac Data**

To allow the Internet Guest Account to use the ACCPAC Shared Data folder, you must add it to the user list, just as you added it for the SageCRM program files directory.
To allow the Internet Guest account to access shared data:

1. In Windows Explorer, navigate to the Sage ERP Accpac Shared Data folder. The default folder location is \Program Files\Sage Software\Sage ERP Accpac).
2. Right-click the folder, and then click Properties.
3. In the Properties form, click the Add button.
4. Select the Internet Guest Account ("IUSR_<ComputerName>")
5. Click the Add button.
6. Click OK.
8. Select the Allow option for the Full Control permission.

The directory permissions are now set for SageCRM.

You can now start SageCRM, but you will not be able to access Sage ERP Accpac information. Proceed to the next section to add the required registry rights to allow this.

**Setting Registry Permissions for the Internet Guest Account**

The Internet Guest Account must have permissions to access the registry to find the Sage ERP Accpac program settings.
To set registry permissions for the Internet Guest Account:

1. On the Windows taskbar, click **Start > Run**.
2. Type **regedit**, and then click **OK**.

3. On the Registry Editor form, select **HKEY_LOCAL_MACHINE > HKEY_LOCAL_MACHINE\SOFTWARE**:

4. On the **Edit** menu, click **Permissions**.

The Permissions form appears:
5. Click the **Advanced** button.
6. Click **Add**.
7. Select the IUSR_<ComputerName> account.
8. Click **OK**.
9. Select the **Allow** option for the Full Control permission:

![Permission Entry for SOFTWARE](image)

10. Click **OK**.
11. On the Advanced Security Settings form, click **Apply** to apply your changes:

![Advanced Security Settings for SOFTWARE](image)

12. Click **OK**.
Setting Path Statements

You need to ensure that path statements are set to allow SageCRM to connect to Sage ERP Accpac using the path to the Sage ERP Accpac Runtime directory. (The default installation location is C:\Program Files\Sage\Sage ERP Accpac\Runtime).

**Note:** If you are installing SageCRM and Sage ERP Accpac on separate servers, do not perform this step until you have installed Sage ERP Accpac using the Sage ERP Accpac Workstation Setup installation on the SageCRM machine.

For details, see the section “Setting up SageCRM and Sage ERP Accpac” in this chapter.

**To set path statements:**

1. On the Windows desktop, right-click **My Computer**, and then select **Properties**.
2. Click the **Advanced** tab.
3. Click **Environment Variables**:

   ![](image.png)

   The Environment Variables form appears.
4. In the System Variables group, in the **Variable** column panel, click **Path**.
5. Click **Edit**.

**Important:** You must set the path statement in the System Variables group, **not** in the User Variables group.
Setting this path statement in the System Variables group sets the path for all users, including the Internet Guest Account.

The Edit System Variable form appears.

6. Append the Sage ERP Accpac path C:\Program Files\Sage\Sage ERP Accpac\Runtime to the end of the existing path statement:

```
Variable Name:  PATH
Variable Value: PSWA;C:\Program Files\COM\RUNTIME;C:\Program Files\Sage ERP Accpac\Runtime
```

**Note:** You must consider the following points before you proceed:

- Use a semicolon (";") to separate the new path from the existing path.
- The paths shown in this example are the default installation directories. If you installed Sage ERP Accpac in a different directory, you will need to adjust the entries accordingly.

7. Click **OK** to save your changes to the Path variable.

8. Click **OK** to close the Environment Variables form.

9. Click **OK** to close the System Properties form.

We recommend that you restart your computer to ensure that all of the new settings are applied.

**Disabling Connection Pooling If You Use COM/DCOM**

You should disable connection pooling if you are using COM/DCOM in either of the following ways:

- In SageCRM integration setup (in the **Accpac Server Name** field that appears after you click **Administration > Sage Accpac Administration > Setup Integration**.)

- In Sage ERP Accpac integration setup (that is, in the **SageCRM Synchronization Method** field of the Sage ERP Accpac E/W SageCRM Setup form)

**Note:** The DCOM synchronization method is not supported in Sage ERP Accpac 6.0.
To disable connection pooling:

1. On the Windows taskbar, click Start > Programs > Administrative Tools > Data Sources.

2. Click the Connection Pooling tab.

   A list of ODBC drivers appears. (Note that if SQL Native Client appears on this list, you must also perform Step 6 below.)

3. On the list that appears, double-click SQL Server.

   The Set Connection Pooling Attributes form appears.

4. Select the Don’t pool connections to this driver option, and then click OK.

5. Restart the server.

6. If SQL Native Client appears on the list of connection drivers, repeat this procedure for that driver.

**Additional User Permissions for COM/DCOM (Single Server Setup)**

This section explains how to configure additional permissions for Windows users who access Sage ERP Accpac (or SageCRM) from a workstation or a server.
Note: These additional permissions are needed only if you are integrating SageCRM with Sage ERP Accpac 5.6 and using the COM/DCOM method of connecting from Sage ERP Accpac to SageCRM. If you are using Web Services, no other settings are needed.

See Chapter 5 for information about COM/DCOM and Web Services when choosing integration and notification options.

MachineKeys Folder Permission

Windows users who edit customer and vendor information and transactions in Sage ERP Accpac require MachineKeys folder permissions. By default, the MachineKeys folder is located in one or both of the following directories:

- C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys
- C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\DSS\MachineKeys

If a MachineKeys folder exists in both directories, set the permission for both folders.

To set MachineKeys folder permissions:

1. In Windows Explorer, open a directory that contains a MachineKeys folder.
2. Right-click the MachineKeys folder, and then click Properties.
4. Click Add.

The Select Users or Groups form appears.

5. Enter the name of the user or group to which you want to assign MachineKeys folder permissions.
6. Click OK.
7. On the **Security** tab, select the user or group you added.

8. Select the **Allow** option for the Full Control permission. (Full Control automatically selects all the other permissions, except Special Permissions.)

9. Click **OK**.

### Access and Launch Permissions

Windows users require Access and Launch permissions for the eware.CRM DCOM object. If you use default security settings for this object, you must ensure that users have default Access and Launch permissions.

**To set Access and Launch permissions:**

1. On the Windows taskbar, click **Start > Programs > Administrative Tools > Component Services**.

2. On the list that appears, select **Component Services > Computers > My Computer**:
3. Select **DCOM Config**:

![DCOM Config](image)

4. In the list of DCOM objects, find the eware.CRM object. Its name uses the format `eware.CRMInstallname`; for example, `eware.CRMQ8`.

5. Right-click the eware.CRM object, and then click **Properties**.

6. On the Properties form, click the **Security** tab.

7. In the Launch and Activation Permissions group, select the **Customize** option, and then click **Edit**.

![Security Tab](image)

8. On the Launch Permission form, click the **Add** button

9. On the Select Users, Computers, or Groups form, enter the name of the user or user group you want to add, and then click **OK**.

10. On the Launch Permission form, select the user or group you added.
11. Select the **Allow** option for all permissions:

![Image of the Launch Permission window]

12. Click **OK**.

13. Follow Steps 7 through 12 for the Access Permissions group:

![Image of the Access Permissions window]

**Permission to Read the Registry on the SageCRM Server**

For the E/W SageCRM Setup form in Sage ERP Accpac, the logged-on Windows user needs to be able to read the registry on the SageCRM server. On some operating systems (such as Microsoft Windows XP), the default setting allows only administrators to read from the registry when logged on remotely.

To allow users to read the registry, visit the Microsoft Knowledge Base at http://support.microsoft.com/kb and search for article 153183, or use the following procedure.
To assign Read Registry permissions to users:

2. Type Regedit and then click OK.
3. The Registry Editor form appears.
4. Select HKEYLOCAL_MACHINE\SYSTEM > CurrentControlSet > Control > SecurePipeServers.
5. Right-click winreg, and then click Permissions.
6. Click Add.
7. On the Select Users, Computers, or Groups form, enter the name of the user or group you want to add, and then click OK.
8. On the Permissions for winreg form, select the user or group you added.
9. Select the Read option.
10. Click OK.

Setting up SageCRM and Sage ERP Accpac on Separate Servers

This section explains how to configure server access if you have installed SageCRM and Sage ERP Accpac on separate servers. For instructions on how to configure server access if you have installed SageCRM and Sage ERP Accpac on a single server, see the previous section in this chapter, “Setting Up SageCRM and Sage ERP Accpac on a Single Server”.

The following is a summary of the steps for setting up SageCRM and Sage ERP Accpac on separate servers after you have installed Sage ERP Accpac and SageCRM.
To set up SageCRM and Sage ERP Accpac on separate servers:

1. Install the Sage ERP Accpac Integration (E/W) Component on the Sage ERP Accpac server but do not set it up yet. For installation details, see Chapter 5, “Sage ERP Accpac Integration (E/W) Component.”

2. Configure access permissions for the IIS Anonymous Access Account on the SageCRM and Sage ERP Accpac servers. See the next section, “Setting Up the IIS Anonymous Access Account.”

3. On the SageCRM server:
   a. Install Sage ERP Accpac Workstation.
   b. Set up the Sage ERP Accpac Integration (E/W) Component.

   See the section “Setting Up Sage ERP Accpac Workstation and Integration on the SageCRM Server” in this chapter.

4. In SageCRM, set up Sage ERP Accpac integration.

5. Set up the ISAPI redirector to direct all SDataServlet requests to be handled by Tomcat on the ERP server, and create virtual directories for the redirector and ERP static content. See the section “Setting Up the ISAPI Redirector and Virtual Directories” in this chapter.

6. If you are integrating SageCRM with Sage ERP Accpac and using COM/DCOM connection from Sage ERP Accpac to SageCRM, configure additional permissions for Windows users who may be updating SageCRM from Sage ERP Accpac. See the section “Additional User Permissions for COM/DCOM (Separate Server Setup)” in this chapter.

Setting Up the IIS Anonymous Access Account

If you are setting up SageCRM and Sage ERP Accpac on separate servers, you must set the IIS Anonymous Access Account on the SageCRM machine to a domain user account instead of a local machine user account. For instructions, refer to the section “Checking the IIS Anonymous Access Account” earlier in this chapter.

Instead of the default machinename\IUSR_machinename account, you must use a domain account, such as domainname\user1. This user must have the following rights:

- Rights to access SageCRM and Sage ERP Accpac programs and data, as described earlier in “Setting Up SageCRM and Sage ERP Accpac on a Single Server”
- Administrative rights on SageCRM and Sage ERP Accpac servers

In addition, you must change the account under which the SageCRM Application Pool runs to use the IIS Anonymous User Account.
To set the SageCRM Application Pool to use the IIS Anonymous User Account:

1. On the Windows taskbar of the SageCRM server, click **Start** > **Programs** > **Administrative Tools** > **Internet Information Server**.

2. Double-click the server name.

3. Double-click **Application Pools**.

4. Right-click the CRM AppPool entry, and then click **Stop**:

5. Right-click the CRM AppPool entry, and then click **Properties**.

6. On the CRM AppPools Properties form, click the **Identity** tab.

7. In the Application Pool Identity group, select the **Configurable** option.

8. In the User Name and Password fields, enter the name and password of the IIS Anonymous User.
9. Click **Apply**, and then click **OK**.

10. On the Application Pools list, right-click the CRM AppPool, and then click **Start**.

11. Restart IIS as described earlier in “Restarting IIS to Reflect Security Changes.”

After you set the SageCRM Application Pool to use the IIS Anonymous User account, you must add this account to the IIS worker process group (IIS_WPG).

**To add the IIS Anonymous User to the IIS worker process group:**

1. On the Windows taskbar, click **Start > Programs > Administrative Tools > Computer Management**.

2. Select **System Tools > Local Users and Groups > Groups**.

3. Double-click **IIS_WPG**.

4. Click **Add**.

5. On the Select Users, Computers, or Groups form, enter the name of the user.

6. Click **OK**.

7. On the **IIS_WPG Properties** form, click **Apply**, and then click **OK**.

**Note:** After you add the IIS Anonymous User account to the IIS worker process group, ensure that the IIS_WPG group has sufficient rights on the CRM installation folder. The default location is C:\Program Files\Sage\CRM\CRMInstallname.

---

**Setting Up Sage ERP Accpac Workstation and Integration on the SageCRM Server**

For information to flow from Sage ERP Accpac to SageCRM, you must:

- Set up the Sage ERP Accpac workstation on the SageCRM server using Workstation Setup with UNC paths, as described in the *System Manager Administrator Guide*.

- Set up the Sage ERP Accpac Integration (E/W) Component, first on the SageCRM server and then on the ERP server, as described in Chapter 5.
Setting up SageCRM and Sage ERP Accpac on Separate Servers

---

**Note:** After you set up the options in the E/W SageCRM Setup form and run the E/W Workstation Setup utility, restart IIS on the SageCRM server.

When you run the E/W Workstation Setup utility on the SageCRM server, you will be prompted to install the SageCRM Synchronization Component if it has not been installed. You must install this component to create the Web Services connection between Sage ERP Accpac and SageCRM.

For instructions on how to install the integration component and create the Web Services connection, see Chapter 5.

**Setting Up the ISAPI Redirector and Virtual Directories**

To integrate SageCRM and Sage ERP Accpac on separate servers, you must perform the procedures in this section to set up the ISAPI redirector and virtual directories.

Before you start, you will need the following information:

- The name and location of your SageCRM installation
- The name or IP address of the Sage ERP Accpac server
- The number of the port used by Tomcat on the Sage ERP Accpac server

**Setting Up the ISAPI Redirector**

To set up the ISAPI redirector on the SageCRM server so it directs all SDataServlet requests to be handled by Tomcat on the Sage ERP Accpac server, you must find the number of the port used by Tomcat on that server, and then add it and other information to properties fields for the ISAPI redirector.

**To find the Tomcat port number on the Sage ERP Accpac server:**

1. In Windows Explorer, navigate to the location where Tomcat is installed. (The default location is `C:\Program Files\Common Files\Sage\Sage Accpac`.)
2. Navigate to `Tomcat6 > conf`, and then open the server.xml file with the text editing or XML editing software you prefer.
3. Find the `AJP` line, which should look like this:

   ```xml
   <Connector port="10020" protocol="AJP/1.3" ... 
   ```

4. Note the port number. (In the above example, the port number is 10020.)
To set up the ISAPI redirector on the SageCRM server:

1. In Windows Explorer, navigate to the SageCRM installation, and then open **Services > IISUtils > URLRedirector**.

2. Open uriworkermap.properties in text editing software and add the following lines:
   
   `/SDataServlet/*=accpac
   
   `/SDataServlet=accpac

3. Open workers.properties in text editing software and type **accpac** at the end of the first line so that it reads as follows:
   
   `worker.list=<CRM installation name>, accpac`

4. In workers.properties, add the following lines:
   
   `worker.accpac.type=ajp13`
   
   `worker.accpac.host=<name or IP address of Sage ERP Accpac server>`
   
   `worker.accpac.port=<Tomcat port on Sage ERP Accpac server>`

5. Save and close the properties files.

**Editing Accpac_Session.js**

In the JavaScript file Accpac_Session.js, the default value for TWOSERVERSETUP is 0. To integrate SageCRM and Sage ERP Accpac on separate servers, you must set this value to 1.

**To edit Accpac_Session.js:**

1. In Windows Explorer, navigate to **
   \CRM install location\WWWRoot\CustomPages\ACCPAC**.

   For example, if you installed SageCRM in **Program Files\sage**, the install location would be as follows:
   
   `C:\Program Files\sage\CRM\WWWRoot\CustomPages\ACCPAC`

2. Open Accpac_Session.js with the text editing software you prefer.

3. Find the **TWOSERVERSETUP** line, which should look like this:
   
   `TWOSERVERSETUP = 0;`

4. Edit the line as follows to set its value to 1:
   
   `TWOSERVERSETUP = 1;`
5. Save and close the file.

Creating a Virtual Directory for the ISAPI Redirector on the SageCRM Server

To create a virtual directory for the ISAPI redirector on the SageCRM server:

1. Open IIS manager.
2. Right-click Default Web Site and select New > Virtual Directory.
   - The Virtual Directory Creation Wizard appears.
3. Click Next.
4. In the Alias field, type SDataServlet.
5. Click Next.
7. Navigate to `<CRM_HOME>\Services\IISUtils\URLRedirector`, and then click OK.
8. Click Next.
9. On the Access Permissions form, select the Execute option, and then click Next.
10. Click Finish to create the virtual directory.
11. Right-click the SDataServlet icon, and then click Properties.
12. On the Application Pool list, ensure that the CRMUrlRedirector AppPool option is selected, and then click OK.

Creating and Setting Up a Virtual Directory for ERP Static Content on the SageCRM Server

To create a virtual directory for ERP static content on the SageCRM server:

1. In IIS Manager, right-click Default Web Site and select New > Virtual Directory.
   - The Virtual Directory Creation Wizard appears.
2. Click Next.
3. In the Alias field, type SageERPAccpac.
4. Click Next.
5. In the Directory field, type C:\.

6. Click Next to proceed through the remaining screens of the wizard, and then click Finish.

To set up the virtual directory for ERP static content:

1. In IIS Manager, right-click the SageERPAccpac directory you created in the previous procedure, and then click Properties.

2. On the Virtual Directory tab, on the The content for this resource should come from list, select A redirection to a URL.

3. In the Redirect to field, type http://<ERP server name>$V$Q.

4. On the The client will be sent to list, select the following options:
   - The exact URL entered above
   - A permanent redirection for this resource

5. Check the Application name field to make it displays SageERPAccpac.

   **Note:** If the Application name field is disabled, click the Create button. The field should become active and display SageERPAccpac.

6. On the Application Pool list, ensure that the CRMUrlRedirector AppPool option is selected, and then click OK.

7. Click OK.

When you have finished setting up the ISAPI redirector and virtual directories:

- Exit IIS Manager.
- Restart IIS.

**Additional User Permissions for COM/DCOM (Separate Server Setup)**

This section applies only if you are integrating SageCRM with Sage ERP Accpac 5.6 and using COM/DCOM Connection to send information from Sage ERP Accpac to SageCRM. If you are using Web Services connection, you do not need to set up extra permissions.

This section applies to Windows users who may log in and make updates from Sage ERP Accpac to SageCRM; for example, from a Sage ERP Accpac workstation.
For COM/DCOM connection setup, assign Windows users the same permissions described in the section “Setting Up SageCRM and Sage ERP Accpac on a Single Server.” In addition, you may need to assign the following permissions:

- MachineKeys folder permissions on the SageCRM server. See the section "Additional User Permissions for COM/DCOM (Single Server Setup)” for details.

- Remote Launch and Remote Activation permissions for the default DCOM settings.

If you need to assign Remote Launch and Remote Activation permissions, you can use Component services or Computer Management. Procedures for both methods follow.

**To assign Remote Launch and Remote Activation permissions using Component Services:**

1. On the Windows taskbar of the SageCRM server, click **Start** > **Programs** > **Administrative Tools** > **Component Services**.

2. Select **Component Services** > **Computers**.

3. Right-click **My Computer**, and then click **Properties**.

4. Click the **COM Security** tab:

5. In the Launch and Activation Permissions area, click **Edit Limits**.

6. On the Launch Permission form, if your user (or the group to which it belongs) is not listed, click the **Add** button.

7. On the Select Users, Computers or Groups form, enter the name of your user.
8. Click **OK**.

9. On the Launch Permission form, select your user, and then check that all four permissions are selected (**Local Launch**, **Local Activation**, **Remote Launch** and **Remote Activation**):

![Launch Permissions](image)

10. Click **OK**.

11. On the My Computer Properties form, click **Apply**.

12. Restart the server.

As an alternative to setting permissions using Component Services, you can add the Windows user to the server’s Distributed COM Users group.

**To assign Remote Launch and Remote Activation permissions using Computer Management:**

1. On the Windows taskbar, click **Start > Programs > Administrative Tools > Computer Management**.

2. Select **Local Users and Groups > Groups**.

3. In the list of groups, double-click **Distributed COM Users**.
4. On the Distributed COM Users Properties form, click **Add**.

5. On the Select Users, Computers or Groups form, enter the name of the user.

6. Click **OK**.

7. On the Distributed COM Users Properties form, click **OK**.

**Other Settings**

- **Disable Connection Pooling.** See the earlier section “Disabling Connection Pooling If You Use COM/DCOM” for details on when and how to disable connection pooling on the Sage ERP Accpac server. After restarting both servers, you may need to rerun Synchronize Tables in SageCRM (see Chapter 6 for details).

- If you are using .NET to connect SageCRM to Sage ERP Accpac, you will need to add the Sage ERP Accpac web components to the SageCRM server.

  To do so, you must:
  - Run Sage ERP Accpac Web Deployment using .NET remoting. See the *Sage ERP Accpac Installation and System Administrator's Guide* for details.
  - Run Sage ERP Accpac in browser mode (as a web client) on the SageCRM server, up to signing on to your company. This will add the Sage ERP Accpac .NET components to the SageCRM server.

- If you are using .NET web deployment in Sage ERP Accpac (described in the *Sage ERP Accpac Installation and System Administrator’s Guide*), you must run it under an account that has sufficient rights on the Sage ERP Accpac and SageCRM servers (for example, a domain user account).
To select an account for .NET web deployment:

1. On the Windows taskbar, click **Start** > **Programs** > **Administrative Tools** > **Services**.

2. On the list of services, double-click **Sage Accpac .NET Remoting Service**.

3. Click the **Log On** tab.

4. Select a user account with sufficient rights on the Sage ERP Accpac and SageCRM servers.

5. Click **OK**.

Running SageCRM Integrated with Sage ERP Accpac on Windows 2008 Server

This section describes additional requirements for running SageCRM integrated with Sage ERP Accpac on a Windows 2008 server, and addresses issues you may encounter when using this setup.

**Note:** Unless otherwise indicated, the settings described in the previous sections on configuring servers and server access permissions also apply to Windows 2008.

If you are running SageCRM integrated with Sage ERP Accpac on a Windows 2008 server, you need to perform the following tasks:

- Set up IIS Role Services and Parent Paths.
- Set the IIS 7 Impersonated User.
- Set IIS Feature Permissions to Execute.
- Run Internet Explorer as an administrator.
- Use regacc to register Sage ERP Accpac screens.

If you need to run SageCRM and open integrated Sage ERP Accpac screens on a Windows 2008 server while logged in to Windows as a user who is not the local administrator, additional steps are described below in the section “Sunning SageCRM on Windows 2008 as a Non-Administrative User.”
Setting Up IIS Role Services and Parent Paths

After you install IIS as a Server Role, make sure the following Role Services are added to the SageCRM server, in addition to any described in the SageCRM Technical Specification or System Administrator Guide:

- Windows Authentication
- Management Console
- IIS Management Compatibility
- Application Development (to make sure ASP and ISAPI Extensions are installed)

To add IIS Role Services:

2. In the Roles Summary or Features Summary areas of the Server Manager main form, click Add Roles.
3. Right-click Web Server (IIS), and then select Add Role Services.
4. In the list that appears, select the following options:
   - Windows Authentication
   - Management Console
   - IIS Management Compatibility
   - Application Development
5. Save your changes and exit Server Manager.
6. Restart IIS.

After adding Role Services, you must check to ensure that parent paths are enabled.

To enable IIS Parent Paths:

1. In Server Manager, select IIS > Web Server (IIS) > Internet Information Server (IIS) Manager.
2. On the Connections list, select your current server name.
3. On the list of features that appears at the right, right-click ASP, and then click Open Feature.
4. In the form that appears, set Enable Parent Paths to True.
5. Click Apply.
6. Save your changes and exit Server Manager.
7. Restart IIS.

**Setting the IIS 7 Impersonated User**

To run SageCRM integrated with Sage ERP Accpac on a Windows 2008 server, you must set the IIS 7 Impersonated User.

**To set the IIS 7 Impersonated User:**

1. Open IIS.
2. In the left pane, select your server, and then select Web Sites > Default Web Site.
3. Right-click the SageCRM site, and then select Manage Application > Advanced Settings.
4. On the Advanced Settings form, click the browse ("...") button beside the Physical Path Credentials field.
5. Select Specific User.
6. Click Set.
7. Enter the name of the user that should be impersonated by SageCRM.
8. Restart IIS.

**Setting IIS Feature Permissions to Execute**

To run SageCRM integrated with Sage ERP Accpac on a Windows 2008 server, you must set IIS 7 Feature Permissions to Execute.

**To set Feature Permissions to Execute:**

1. In IIS, select the SageCRM installation.
2. In the right panel, double-click Handler Mappings.
3. On the Handler Mappings form, click Edit Feature Permissions.
4. On the Edit Feature Permissions form, select Execute (if it is not already selected).
5. Restart the server.
Running Internet Explorer as an Administrator

If you are running SageCRM and Sage ERP Accpac on separate Windows 2008 servers, you should run Sage ERP Accpac Workstation Setup on the SageCRM server while logged in as an administrator.

If you need to open Sage ERP Accpac in a browser in order to download the .NET components, you should run Internet Explorer as an administrator.

To run Internet Explorer as an administrator:
1. On the Windows taskbar, click Start > Programs.
2. Right-click Internet Explorer and select Run as Administrator.

Using Regacc to Register Sage ERP Accpac Screens

You must run regacc to register the Sage ERP Accpac screens on the Sage ERP Accpac server, and also on the SageCRM server (which has Sage ERP Accpac Workstation Setup on it).

Before you start, check that you are logged in as the local administrator.

To run regacc:
2. Type regacc and click OK.
3. The Register Accpac Programs message appears.

You may need to repeat this task if you are logged in as a different user and the Sage ERP Accpac desktop does not open properly.

Running .NET Remoting Service under the Local Administrator Account

If you are using .NET, you must run the Sage ERP Accpac .NET remoting service under the local administrator account, even if you have used the Web Deployment Wizard to run Sage ERP Accpac using a different account (for example, a domain account).

To run .NET remoting under the local administrator account:
3. On the Properties form, click Stop to stop the service.
4. Click the **Log On** tab.
5. Under **Log on as**, select **This account**.
6. Enter the name and password of the local administrator.
7. Click **OK** to save your settings.
8. To re-start the service, right-click **Sage Accpac .NET Remoting Service**, and then click **Start**.

### Running SageCRM on Windows 2008 Server as a Non-Administrative User

If you need to run SageCRM on the Windows 2008 server while logged in to Windows as a user who is not the local administrator, and you wish to open the Sage ERP Accpac screens from within SageCRM on the server, you may need to do one or all of the following, depending on your security settings:

- Run Internet Explorer as an administrator (refer to the previous section “Running Internet Explorer as an Administrator”)
- Set a4wSignonMgr to run as administrator
- Check that controls have not been disabled

**To set a4wSignonMgr to run as administrator:**

1. Navigate to the \Sage ERP Accpac\Runtime folder.
2. Right-click **a4wSignonMgr.exe**.
3. Click the Compatibility tab.
4. Select the **Run as Administrator** option.
5. Click **OK**.
6. Restart the server.

If a control will not open, you can check to see if it has been disabled in Internet Explorer.

**To check for disabled controls:**

1. Open Internet Explorer.
2. On the **Tools** menu, click **Manage Add-Ons**.
3. If any “eCRM*.∗” or “Accpac*.∗” control is marked as disabled, select the control and click the **Enable** button.
4. When you are finished, click **Close**.

**Notes:**

- For 64-bit installation, ensure that IIS is running both SageCRM and Accpac as 32-bit applications. For details, see the *SageCRM System Administrator Guide* and the *Sage ERP Accpac Installation and System Administrator's Guide*.

- Ensure that the CRM Application Pool and the Sage ERP Accpac application pool (Sage ERP Accpac uses the default application pool by default) are running in Classic pipeline mode.

- If you need to install Microsoft .NET Framework 1.1 as part of the Synchronization Component install, a Windows compatibility warning message may appear. If you see this message, disregard it and continue with the .NET installation. In addition, we recommend you install the latest service pack for .NET 1.1.

**Now You Can...**

- Explain how server resources are accessed through a browser.

- Explain how to work with IIS.

- Configure server access on the SageCRM and Sage ERP Accpac servers if they are installed on the same server.

- Configure server access if you have installed SageCRM and Sage ERP Accpac on separate servers.
Chapter 5  
Sage ERP Accpac Integration (E/W) Component

In this chapter you will learn how to install, activate, and set up the Sage ERP Accpac Integration Component.

The Sage ERP Accpac Integration Component, also known as the E/W component, must be installed with Sage ERP Accpac so it can integrate with SageCRM. The E/W component establishes a seamless link between your Sage ERP Accpac accounting system and SageCRM, allowing information to flow from Sage ERP Accpac to SageCRM, and from quotes or orders.

Note: The E/W integration component differs from the integration component for SageCRM introduced in Chapter 3, which enables information to flow from SageCRM to Sage ERP Accpac.

If you have not installed the integration component for SageCRM, you must do so before installing the E/W integration component.

Overview of Steps

To install, activate, and set up the Sage ERP Accpac integration (E/W) component, follow these steps. The rest of this chapter describes each step in more detail.

1. Install the E/W integration component on the server where Sage ERP Accpac is installed, and also on any workstations that have Sage ERP Accpac accounting programs installed.

2. Activate the E/W integration component.

   The following icons appear in the SageCRM folder on the Sage ERP Accpac company desktop:
   - SageCRM Setup
   - Workstation Setup
   - Error Log

3. Open the SageCRM Setup form and select integration and notification options for your system.
4. Run the Workstation Setup utility on any Sage ERP Accpac desktop workstation (whether Sage ERP Accpac programs are installed locally or running from the server) that you wish to integrate with SageCRM. You do not need to run the Workstation Setup utility on the client if you are running a browser client only.

After you select the appropriate options and complete these setup steps, any changes made to customers, customer ship-to addresses, vendors, and vendor remit-to addresses in Sage ERP Accpac are reflected automatically in SageCRM.

Installing the E/W Integration Component

You can install the E/W component from the Sage ERP Accpac DVD or the SageCRM DVD.

The following procedure gives instructions for installing the E/W integration component from the Sage ERP Accpac DVD. If you are installing from the SageCRM DVD, alternative steps are described below.

To install the E/W integration component:
1. Insert the Sage ERP Accpac 6.0 or SageCRM 7.0 Installation DVD.
2. Select an installation:
   - If you are installing from the Sage ERP Accpac DVD, select **SageCRM for Sage ERP Accpac**.
   - If you are installing from the SageCRM DVD, select **Install Sage ERP Accpac Accounting Integration**.
3. Click **Next**.
4. Select an integration option:
   - If you are installing from the Sage ERP Accpac DVD, select **Sage ERP Accpac 6.0 Integration**.
   - If you are installing from the SageCRM DVD, select **Install Integration Component for Sage ERP Accpac 6.0**.
5. Click **Next**.
6. Review the License Agreement carefully, and then select **Yes** to continue.
7. On the Choose Destination Location form, the destination folder (installation directory) defaults to the location of your Sage ERP Accpac system files. You should install the integration component in the same location as Sage ERP Accpac.
8. Click **Next**.

9. The Select Features form appears. All features are selected by default. Click **Next** to use the default feature set.

10. The Select Program Folder form appears. You can accept the displayed program folder name or specify a different folder name, and then click **Next** to start copying files.

The copy status bar informs you that program files are being copied to your computer. When copying is complete, the Installation Complete form box appears.

11. If the SageCRM synchronization component is not installed, a message appears. Click **Yes** to install the Web Services synchronization component.

A Component Setup message appears:

12. Click **OK**.

The Welcome to the SageCRM Synchronization Component Setup Wizard form appears:

13. Click **Next**.

14. Accept the license agreement, and then click **Next**.
Installing the E/W Integration Component

On the Select Installation Folder form:

a. Accept the default location or click Browse to select a location.

b. Select the Everyone option.

c. Click Next.

15. On the Confirm Installation form, click Next.

When the installation is complete, a confirmation message appears:

16. Click Close to complete the installation.

Proceed to the next section to activate the Sage ERP Accpac Integration Component within your Sage ERP Accpac accounting system.
Activating SageCRM Integration within Sage ERP Accpac

After you install the Sage ERP Accpac Integration (E/W) Component, you must activate it.

**To activate the E/W component:**

1. Open Sage ERP Accpac from a workstation.
2. Log on as the ADMIN user in your company database. If security is activated in Sage ERP Accpac, you must enter the password for the ADMIN user.
3. Select **Administrative Services > Data Activation**.
4. On the **Applications for Activation** list, select the appropriate version of SageCRM Integration, and then click **Activate**.
5. The SageCRM Integration Activation form appears.
6. In the **SageCRM Installation Name** field, enter the name of your SageCRM installation.
7. Click **Proceed** to complete the activation.

**Note:** To cancel the activation while it is in progress, click **Close** on the Activation form.

8. When activation is complete, close the Data Activation form.

The SageCRM folder appears on the Sage ERP Accpac desktop:
Selecting Integration and Notification Options

The SageCRM Setup form lets you select several options for running SageCRM with Sage ERP Accpac. You must use this form to select setup options when you first set up SageCRM.

Once you have set up SageCRM Integration, use this form when you want to change your selections.

To use the SageCRM Setup form:

1. In the SageCRM folder, select **SageCRM Setup**.
   
The E/W SageCRM Setup form appears.

2. Review and select the following connection options on the Setup form:
   
   **Suspend All Integration to SageCRM.** Select this option if you do not want any changes in Sage ERP Accpac to be reflected automatically in SageCRM.

   **Suspend A/R Integration to SageCRM.** Select this option if you do not want changes in Accounts Receivable to be reflected automatically in SageCRM.

   **Suspend A/P Integration to SageCRM.** Select this option if you do not want changes in Accounts Payable to be reflected automatically in SageCRM.

   **Suspend O/E Integration to SageCRM.** Select this option if you do not want changes in Order Entry to be reflected automatically in SageCRM.

   **Note:** If you suspend O/E integration to SageCRM, the totals and forecasting information on the Opportunity Summary, Quote Summary, and Order Summary screens will not be updated with information from Sage ERP Accpac.

   You may also see errors when saving quotes or orders in SageCRM if O/E integration is suspended.

   **Suspend A/R Ship-To Addresses Integration to SageCRM** or **Suspend A/P Remit-To Addresses Integration to SageCRM.** Select this option if you do not want changes to these addresses in Accounts Receivable or Accounts Payable to be reflected automatically in SageCRM. (Note that after an installation, these two options are selected by default.)

   **Suspend A/R National Account Integration to SageCRM.** Select this option if you do not want changes to the National Account
relationship in AR Customers to be reflected automatically in SageCRM.

**SageCRM Installation Name.** Ensure that the SageCRM installation is correct (the default is CRM).

If you change this field, click the **SageCRM Web Services URL** button to automatically update the Installation Name portion of the Web Services URL field.

**Logon User.** The default is “CRM”. The CRM user account is created automatically within SageCRM to allow Sage ERP Accpac to connect to it. Accept this default user.

**Password.** To add security to this connection, enter a password.

**Note:** If you change the password for the Logon user, you also need to change the password for this user within SageCRM.

**SageCRM Server Name.** This should default to your computer’s machine name. If SageCRM and Sage ERP Accpac are installed on separate servers, enter the name of the SageCRM server.

If you change this field, click the **SageCRM Web Services URL** button to automatically update the Server Name portion of the Web Services URL field.

**Web Services URL.** The Web Services URL field consists of the SageCRM Server Name field, the SageCRM Installation Name field, and program defaults. For example: http://605DEV05/CRM09/eware.dll/webservices/soap

where 605DEV05 is the server name, and CRM09 is the installation name.

If you make changes to the SageCRM Server Name field or the SageCRM Installation Name field, click the **SageCRM Web Services URL** button to automatically update the corresponding portions of the URL field.

Alternatively, you can simply type over the existing value in the URL field. The server name and installation name used in the URL must be the same as the value in the SageCRM Server Name field and the SageCRM Installation Name field.

3. Review the notification options at the bottom of the Setup form.

**Acknowledge operations.** By default, whenever a customer or vendor record is edited and saved in Sage ERP Accpac, a notification informs the user that the update to SageCRM was successful. Uncheck this option if you do not want to receive notification messages.
**Display errors.** By default, the integration component alerts the user to any problems that occur when the program tries to update a customer or vendor in SageCRM. You can turn this option off and view the error log to review any problems.

**Log errors.** This option allows the administrator to turn on or off the logging of errors received by the integration component.

4. Click **Save** to complete the setup process.

---

**Setting Up Sage ERP Accpac Workstations**

You must run the Workstation Setup utility on any Sage ERP Accpac desktop workstation that you want to integrate with SageCRM, whether Sage ERP Accpac programs are installed locally or running on the server. You do not need to run the Workstation Setup utility on the client if you are running a browser client only.

**To run workstation setup:**

1. Start Sage ERP Accpac on the workstation you want to set up.

2. Select the SageCRM folder, and then select **Workstation Setup**.

3. If the SageCRM synchronization component has not yet been installed, a message appears:

   ![Confirmation dialog](image1)

   Click **Yes** to install the synchronization component, and then follow the instructions provided by the setup wizard. For detailed instructions, see the section “Installing the E/W Integration Component” earlier in this chapter.

4. A message informs you if the workstation is currently set up to communicate with SageCRM:

   ![Message dialog](image2)
Now You Can...

- Install the E/W integration component.
- Activate SageCRM integration within Sage ERP Accpac.
- Select your integration and notification options.
- Set up Sage ERP Accpac workstations.

**Note:** This message appears even if the communication connection between SageCRM and Sage ERP Accpac is not successful. You can test the connection in a following step.

5. Click **Close**.

9. The E/W SageCRM Workstation Setup form appears and displays the Web Services URL:

   ![Image](image_url)

   6. To test the connection, click the **Test** button.

   7. Click **Close** to exit.

**Note:** If you move SageCRM to another installation location or to a different server, you must rerun the SageCRM Setup program and the SageCRM Workstation Setup utility.

Now You Can...
Chapter 6
Setting Up Sage ERP Accpac Integration in SageCRM

In this chapter you will learn how to log on to SageCRM, select integration settings, synchronize tables and currency, import accounts, convert existing Order Entry documents, and set up Sage ERP Accpac security.

Logging On to SageCRM

On the SageCRM server, you can start SageCRM from the Windows taskbar by clicking **Start > Programs > SageCRM 200** (or **SageCRM 100**).

On a client workstation, use the following procedure to start SageCRM.

**To start SageCRM:**

1. Open an Internet Explorer browser window.

2. In the address bar, enter the SageCRM installation’s URL in the following format:

   \[http://<servername>/<crminstallation>\]

   For example, if your SageCRM server name is ACCPAC, and you installed SageCRM with the default installation name of CRM, enter the following into your browser:

   \[http://ACCPAC/CRM\]

   The **Log On** screen appears.

3. Enter **admin** in the User Name field, and leave the Password field blank.

4. Click the **Log On** button.

   SageCRM displays the splash screen, or the My CRM work area.
Selecting Integration Settings

If this is a new installation, you must configure the connection to the Sage ERP Accpac database by selecting integration settings.

**To select integration settings:**

1. On the left sidebar, click **Administration**.
2. On the Administration screen, click **Sage Accpac Administration**.

   The Sage Accpac Administration screen appears:

   ![Sage Accpac Administration](image)

3. Click **Setup Integration**.
4. To add a link to a new database, click the **New** button in the right sidebar.
5. The Sage Accpac Integration Configuration screen appears:

   ![Sage Accpac Integration Configuration](image)

6. Complete this form with the following information:
   
   - **Accpac company database ID.** (For example, SAMLTD.)
   
   - **Accpac Company name.** (For example, Sample Company Limited.)

   **Accpac Server Name.** Enter the name of the Sage ERP Accpac server or computer. If you are using .NET web deployment, use .NET notation, in the form net://<machinename>:9000 (where 9000 is the port used by .NET remoting).

   **Note:** We recommend that you do **not** select the **Encryption** option when running the Sage ERP Accpac Web Deployment Wizard.

   - **Default Company.** Select this option to set this as the default company. (You must select one company to be the default.)
7. Click **Save**.
8. If you are finished, click **Continue** to exit. If you want to add another company, repeat steps 3 to 6.

The Sage Accpac Administration screen appears. Because you have set up integration settings, the **Synchronize Tables** option is now available.

### Synchronizing Tables

The Synchronize Tables function updates SageCRM database tables with the tables defined for the following fields in the Sage ERP Accpac database:

- Groups
- Tax Groups
- Terms
- Salespersons
- Currencies

You must synchronize tables after the installation is completed and before you add any data to the system.

**To synchronize tables:**

1. On the Sage Accpac Administration screen, click **Synchronize Tables**.

   The Select Sage Accpac Integration Tables to Synchronize screen appears.

2. On the **Accpac Company Name** list, select a company name.

3. Select each of the tables that you want to synchronize.
Resetting Currency in New Installations

**Note:** If the **Currency Upload** check box does not appear, and this is a new SageCRM install (not an upgrade), and you need to import currency, please see the following section "Resetting Currency in New Installations”.

4. Click the **Synchronize** button.

When synchronization is completed, SageCRM displays the values extracted from the Sage ERP Accpac database:

<table>
<thead>
<tr>
<th>Group Code</th>
<th>Group Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>EUR</td>
<td>Euro</td>
</tr>
<tr>
<td>Customer</td>
<td>GBP</td>
<td>British Pound</td>
</tr>
<tr>
<td>Customer</td>
<td>JPY</td>
<td>Japanese Yen</td>
</tr>
<tr>
<td>Customer</td>
<td>NZD</td>
<td>New Zealand Dollar</td>
</tr>
<tr>
<td>Customer</td>
<td>AUD</td>
<td>Australian Dollar</td>
</tr>
<tr>
<td>Customer</td>
<td>SGD</td>
<td>Singapore Dollar</td>
</tr>
<tr>
<td>Customer</td>
<td>CAD</td>
<td>Canadian Dollar</td>
</tr>
<tr>
<td>Customer</td>
<td>HKD</td>
<td>Hong Kong Dollar</td>
</tr>
<tr>
<td>Customer</td>
<td>SEK</td>
<td>Swedish Krona</td>
</tr>
<tr>
<td>Customer</td>
<td>NZD</td>
<td>New Zealand Dollar</td>
</tr>
</tbody>
</table>

5. Click **Continue**.

6. Repeat for each company.

**Resetting Currency in New Installations**

After you perform integration and synchronize tables, the base currency is removed and all currency exchange rates are set to 1. You must reset the base currency, and then set up currency rates against the base currency if you are using multicurrency.

**To reset base currency:**

1. On the left sidebar, click **Administration**.

2. Click **Data Management**.
3. Click Currency Configuration.
4. On the right sidebar, click Change

If you are using multicurrency, you must reset currency rates against the base currency.

To reset currency rates against base currency:
1. On the left sidebar, click Administration.
2. Click Data Management
3. Click Currency.
4. Click the name of a currency to edit the rate.

For more information on setting up currencies in SageCRM, refer to the “Multicurrency Support” chapter in the SageCRM System Administrator Guide.

Currency Troubleshooting

In exceptional circumstances, you may need to synchronize currencies manually.

For example, if you have an existing SageCRM installation set up with currencies and you want to integrate it with Sage ERP Accpac, the Currency Upload check box and Currencies button are not available because currencies are already set up.

**Important:** If you synchronize currencies, you delete all existing currency values, so any value in the database that contains a currency value is affected. After you synchronize, you must reset all currency rates against the base currency.

- To display the Currencies button in the Sage Accpac Administration screen, insert the parameter ManualCurrency, with a value of Y, into the SageCRM database’s Custom_Sysparams table.
- To display the Currency Upload check box on the list of currencies to synchronize, insert the parameter CanImportCurrency, with a value of Y, into the SageCRM database’s Custom_Sysparams table.
Importing Customer, Vendor, and National Account Relationships from Sage ERP Accpac

The Import Customers and Import Vendors functions let you import a range of customers and vendors from Sage ERP Accpac Accounts Receivable and Accounts Payable into SageCRM.

To import customers, vendors and national accounts into SageCRM:

1. On the Sage Accpac Administration screen, click **Import Customers** (or **Import Vendors**).

   The **Import** tab appears:

2. On the **Accpac Company Name** list, select a company.

3. Select records to import.
   - If you are importing customers, you can select customer records, or ship-to address records, or both.
   - If you are importing vendors, you can select vendor records, or remit-to address records, or both.

   **Note:** If you import ship-to addresses or remit-to addresses, you must also import the associated customer or vendor records at the same time, **unless** the customer or vendor records have already been imported into SageCRM.
For example, if you had previously imported customers 1000 to 2000, you can select Import Ship-To Addresses for customers 1000 to 2000, without selecting Import Customers.

You use these import options in conjunction with the From/To Customer Number (or From/To Vendor Number) fields — see the next step.

4. Specify the range of customers or vendors that you want to import, or leave the default values in the From and To fields to import all customers or vendors.
   - If you are importing customers, the range you specify is applied to both the Import Customers and Import Ship-To Addresses fields.
   - If you are importing vendors, the range you specify is applied to both the Import Vendors and Import Remit-To Addresses fields.

**Note:** In step 4, if you selected only the Import Ship-To Addresses option for customers or only the Remit-To Addresses option for vendors, SageCRM will import the addresses of the customers or vendors that fall within the specified range.

For example, if you specified a customer range from 1000 to 2000, SageCRM imports the ship-to addresses of customers 1000 to 2000.

5. Click the Import from Sage ERP Accpac button.

A list of 100 customers or vendors appears at a time while they are being imported.

**Note:** If you are importing data from a large database for the first time may be lengthy.

When the process is complete, SageCRM displays the number of customers or vendors (and ship-to and remit-to addresses) imported, and the Continue button appears.

6. Click Continue to return to the Sage Accpac Administration screen.
7. Repeat steps 1 to 6 to export vendors.

If you want to import National Accounts information from Sage ERP Accpac, use the following procedure.

**To import national accounts:**
2. Specify a range of accounts to import, and then click the **Import from Sage Accpac** button.

SageCRM imports the accounts and a confirmation screen appears.
3. Click **Continue** to exit.
4. Repeat steps 1 to 3 for each company.

**Converting Existing Sage ERP Accpac O/E Quotes and Orders**

If you are upgrading to SageCRM 7.0 integrated with Sage ERP Accpac version 6.0, you must convert existing Order Entry quotes and orders to make them compatible with the new integration.

SageCRM converts **only** existing quotes and orders that are linked to SageCRM opportunities.

After successful conversion, SageCRM displays information from converted documents in opportunity totals and forecast amounts on all summary screens for an opportunity.

---

**Note:** If you convert existing invoices or shipments that include miscellaneous charges, the amount of the miscellaneous charges is not reflected in opportunity totals and forecast amounts.

When you activate Sage ERP Accpac 6.0 Order Entry, the following fields are added to the OERDH, SHID, and INVD tables:

- Company ID
- Opportunity ID
When you run conversion in SageCRM, the program performs the following tasks:

- Searches for Order Entry documents with eCRM Ref# = x in the Reference field, clears the Reference field, and adds Opportunity ID, Company ID, and Person ID to the appropriate tables.
- Updates the Opportunity and Opportunity Items tables to support showing Opportunity Totals and Forecast amount.
- Sets all existing quotes to be included by default in the Opportunity Totals shown on the Opportunity Summary screen.

During conversion, any SageCRM companies with quotes or orders for non-existent customers (customers not linked to Sage ERP Accpac Accounts Receivable) will be linked to the Sage ERP Accpac company database you select during conversion.

**Conditions for Successful Conversion**

To be converted successfully, documents must meet the following conditions:

- Opportunity Status must be In Progress
- Order Type must be Active or Quote
- All quotes used to create an order must belong to the same opportunity as the order
- An order that was created from one or more quotes must contain opportunity information in the Reference field

Before starting conversion, make sure the documents you need to convert meet the above conditions.

**Important:** If any document belonging to an opportunity fails to meet any of the above conditions, no documents that belong to that opportunity will be converted.

If you view an opportunity that could not be converted, you will not see any existing quotes or orders linked to that opportunity. The forecast and totals for the opportunity may also show incorrect information or a "Currency not set" message.

If you need to keep any documents that belong to an opportunity that could not be converted, you may need to remove and reenter the opportunity and all transactions associated with it.
To convert existing documents for SageCRM 7.0 integration:

1. Log on to SageCRM.
2. On the left panel, click the Administration link.
3. On the Administration screen, click the Sage Accpac Administration icon.
4. On the Sage Accpac Administration tab, click the Convert OE Quotes and Orders icon.
   The Convert existing Sage ERP Accpac O/E Quotes and Orders tab opens.
5. On the Accpac Company Name list, select a company name.
6. Enter a range of customer numbers to convert. You can use the default values in the From Customer Number and To Customer Number fields to select all documents, or specify a limited range if you have a large number of documents to convert.
7. On the right panel, click Convert Sage Accpac O/E Data.
   SageCRM begins converting the documents you selected.

After conversion, a conversion log lists opportunities that were successfully converted and opportunities that could not be converted, grouped by customer number. A copy of the log file is saved to the Sage ERP Accpac COMPANY directory.

Notes:

- Unlike the conversion log that appears in SageCRM after conversion, the saved log file does not group opportunities by customer number.
- If a miscellaneous charge has been added to a shipment or invoice for an order linked to an opportunity that is being converted, the amount of the miscellaneous charge will not appear in the shipment or invoice totals.

Setting Up Sage ERP Accpac Security

On the Sage Accpac Administration screen, you can set up two levels of security: user level and database level.

- **User Level.** You use Sage ERP Accpac user-level security to define a user’s access permissions for integrated screens, such as A/R Inquiry. These permissions apply to all Sage ERP Accpac integrated databases.
Setting Up Sage ERP Accpac Security

except the databases specified in Sage ERP Accpac Database-Level Security.

- **Database Level.** You use Sage ERP Accpac Database-Level Security to define a user’s access permissions for integrated screens, such as A/R Inquiry, where the rights apply only to one Sage ERP Accpac integrated database.

For example, assume you have integrated SageCRM with two Sage ERP Accpac databases: SAMINC and SAMLTD. You want user JOHN to have access to all Sage ERP Accpac integrated screens (A/R Inquiry, A/R Invoice, and so on) while working with SAMINC. However, while working with SAMLTD, user JOHN should not have access to the A/R Inquiry screen.

In this case, you would use Sage ERP Accpac User-Level Security to assign user JOHN permissions for all Sage ERP Accpac integrated screens, which would apply to all integrated databases (SAMINC and SAMLTD). You would then use Accpac Database-Level Security to revoke user JOHN’s access permissions for the A/R Inquiry screen for SAMLTD.

If customer 1200 existed in both SAMINC and SAMLTD, user JOHN would see the A/R Inquiry screen if viewing customer 1200 from SAMINC, but would not see the A/R Inquiry screen if viewing customer 1200 from SAMLTD.

**Setting Up Sage ERP Accpac User-Level Security**

On the Sage Accpac Administration screen, Sage ERP Accpac User-Level Security allows you to assign access permissions for integrated Sage ERP Accpac screens for all users, and to assign permissions for specific integrated screens, such as A/R Inquiry, to individual users.

These rights apply to all Sage ERP Accpac integrated databases except any databases you specify in Sage ERP Accpac Database-Level Security.

**Note:** You can assign SageCRM-related permissions for individual users on the SageCRM Administration screen by clicking the *Users* button.

When you click *Accpac User-Level Security*, a list of users appears:

<table>
<thead>
<tr>
<th>User Name</th>
<th>Last Name</th>
<th>First Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>Administrator</td>
<td>System</td>
</tr>
<tr>
<td>CRM</td>
<td>CRM</td>
<td>Accpac</td>
</tr>
<tr>
<td>SUEDE</td>
<td>Smith</td>
<td>Susan</td>
</tr>
</tbody>
</table>

You can use this screen to edit user permissions for integrated Sage ERP Accpac screens for all databases (except any specified in Accpac Database-Level Security).
To edit user permissions for integrated Sage ERP Accpac screens for all databases:

1. On the Sage Accpac Administration screen, click the name of a user in the User Name column.
   
   The Accpac User-Level Security tab appears.

2. To start editing permissions for a user, click the Change button.

3. Enter the user’s Sage ERP Accpac User ID and Password.
   
   SageCRM uses this information to access Sage ERP Accpac data.

   **Note:** The Sage ERP Accpac User ID and Password must already exist in Sage ERP Accpac.

4. Select and clear check boxes to set user permissions for integrated Sage ERP Accpac screens.

5. When you have finished, click Save.

6. To return to the Sage Accpac Administration screen, click Continue.

### Setting Up Sage ERP Accpac Database-Level Security

On the Sage Accpac Administration screen, Sage ERP Accpac Database-Level Security lets you assign access permissions for Sage ERP Accpac integrated screens, such as A/R Inquiry, where the rights apply only to the specific user and Sage ERP Accpac integrated database that you select.

When you click Accpac Database-Level Security, the following screen appears if there are users set up for database-level security:

If no users have been set up, the Accpac Database-Level Security tab appears.

**To edit user access permissions for an integrated Sage ERP Accpac database:**


2. On the right sidebar, click New.

3. On the User Name list, select a user.
4. Click the Finder to the right of the **Accpac Company Name** field, and then select a company on the list that appears.

5. Type the user’s Sage ERP Accpac User ID and Password in the **Accpac User ID** and **Accpac Password** fields.

*SageCRM uses this information to access Sage ERP Accpac data.*

*Note:* The Sage ERP Accpac User ID and Password must already exist in Sage ERP Accpac.

6. Select and clear check boxes to set user permissions for integrated Sage ERP Accpac screens.

7. When you have finished, click **Save**.

8. To return to the Sage Accpac Administration screen, click **Continue**.

---

**Setting Up User-Level Security on the SageCRM User Record**

You can also set up user-level security directly on the SageCRM user record. Note that this security layer is not a replacement for the Sage ERP Accpac security; it is simply a way to show or hide a screen.

**To set up user-level security on the SageCRM user record:**

1. On the Administration screen, click the **Users** button.

2. On the Users screen, click **Users**.

*Note:* Each user is set up in the SageCRM Admin Users section. (For details, see the “User Administration” chapter in the *SageCRM System Administrator Guide*.)

3. Add a new user or search for an existing user.
   
   - To add a new user, click **New** on the right sidebar.
   
   - To search for an existing user:
     
     i. Specify search criteria in the fields on the Find tab.
     
     ii. On the right sidebar, click **Find**.
     
     iii. On the User Details screen, click **Change**.
4. On the **More User Details** tab at the bottom of the screen (two **More User Details** tabs appear on this screen), enter the user’s Sage ERP Accpac User ID and Password:

   ![More User Details Table]

   **Note:** You must enter a unique Sage ERP Accpac User ID and Password even if security in Sage ERP Accpac has been disabled.

5. Click check boxes to assign permissions for Sage ERP Accpac integration functions that this user is allowed to perform.

6. Click **Save** to save your changes.

**Now You Can...**

- Install the Sage ERP Accpac integration component.
- Activate SageCRM within Sage ERP Accpac.
- Set up Sage ERP Accpac workstations.
- Explain integration options.
Chapter 7
Using SageCRM with Sage ERP Accpac

In this chapter you will learn how to:

- Identify how SageCRM screens change after integration with Sage ERP Accpac.
- View and modify company and opportunity information in SageCRM.
- Promote SageCRM customers or vendors to Sage ERP Accpac.
- Create O/E quotes and orders in SageCRM.
- Use SageCRM Inquiry features.

Overview

After you integrate SageCRM with Sage ERP Accpac, new screens appear in SageCRM that you can use to view and edit Sage ERP Accpac information. Some existing SageCRM screens are also updated to add new features that enable you to view and edit Sage ERP Accpac information.

Refer to the following section “Integration Changes to SageCRM Screens” for a summary of these changes.

Note: The integrated tabs and customer and vendor information are available only if you have set up the integration link and imported information from Sage ERP Accpac.

Integration Changes to SageCRM Screens

When you integrate SageCRM with Sage ERP Accpac, new screens are added to SageCRM, and there are changes to the features and functionality of some existing screens. The following sections describe the new screens and changes to existing screens.
SageCRM Tabs and Screens Added During Integration

When SageCRM is successfully integrated with Sage ERP Accpac, the following new tabs and screens appear in the Company context (when you have selected a company):

- Promote to Accpac
- A/P Inquiry / A/R Inquiry
- Vendor Statistics / Customer Statistics
- Optional Fields
- P/O Inquiry / O/E Inquiry
- P/M Inquiry
- R/A Inquiry

**Note:** Except for the Promote to Accpac screen, the above screens are specific to a SageCRM system with Sage ERP Accpac integration and appear only if the selected company is also a customer or vendor in Sage ERP Accpac.

The following new tabs and screens appear in the Opportunity context (when you have selected an opportunity):

- Quotes (includes Quote Summary and Quote Entry screens)
- Orders (includes Order Summary and Order Entry screens)

The following table gives a brief overview of each screen and its function.

**Quotes**

The Quotes screen lists Sage ERP Accpac quotes for an opportunity, and allows you to create quotes, edit existing quotes, and review totals and other key information at a glance, all without opening Sage ERP Accpac. On this screen, you can:

- View quote totals, including the amount promoted to Sage ERP Accpac orders.
- View information about all quotes created for the opportunity, including associated orders, expiration dates, and whether each quote is included in opportunity totals.
- Click **New Quote** to create a new quote for an open opportunity in SageCRM without opening Sage ERP Accpac.
- Click an existing quote to open it in the Quote Entry screen, where you can view and edit details for the quote and specify whether to include it in opportunity totals.
Integration Changes to SageCRM Screens

- Select one or more quotes to promote to a Sage ERP Accpac order.

Orders
The Orders screen lists Sage ERP Accpac orders for an opportunity, and allows you to create orders, edit existing orders, and review totals and other key information at a glance, all without opening Sage ERP Accpac.

On this screen, you can:

- View order totals, including order amount, shipment amount, and invoice amount.
- View information about all orders created for an opportunity, including document number, associated quotes, and whether an order is on hold.
- Click **New Order** to create a new order for an active customer in SageCRM without opening Sage ERP Accpac.
- Click an order to open it in the Order Entry screen, where you can view and edit details for the order.

Promote To Accpac
The Promote To Accpac screen shows Sage ERP Accpac details about an existing customer or vendor. You can use this screen to promote a SageCRM company to a Sage ERP Accpac customer or vendor.

A/R Inquiry (Customers)
The A/R Inquiry screen lists posted or unposted Accounts Receivable documents for a company.

You can view document details, create and edit documents, and display a list of applied transactions for a document. This tab appears only for companies with a Sage ERP Accpac Customer Number.

A/P Inquiry (Vendors)
The A/P Inquiry screen lists posted or unposted Accounts Payable documents for a company. You can edit unposted documents and create new vendor documents in Sage ERP Accpac.

Aging and Statistics: (Customers and Vendors)
The Customer (or Vendor) Statistics screen displays the following information for customer or vendor records:

- Credit information
- Aging information for outstanding amounts
- Totals for all documents posted to customer or vendor accounts
- Dates and amounts of the last documents posted to customer or vendor accounts

The tab also displays specialized information, such as national account information for a national account customer.

Optional Fields
The Optional Fields screen lists optional fields that are defined in Sage ERP Accpac for a customer or vendor, and lets you edit the optional fields.
Integration Changes to SageCRM Screens

The O/E Inquiry screen displays the following menu items:

- All Orders (active, standing, future, quotes)
- Credit/Debit Notes
- All Shipments
- Pending Shipments
- Sales History
- Customer Price List
- Serial & Lot Number Sales History

Use these screens to view document details, open a document for editing, or create a new O/E document.

The P/O Inquiry screen displays the following menu items:

- All Orders (active, standing, future, blanket)
- Credit/Debit Notes
- All Receipts
- Pending Receipts
- Purchase History
- Vendor Contract Costs
- Requisitions
- Returns
- Serial & Lot Number Purchase History

Use this screen to view document details, open a document for editing, or create a new P/O document.

If you use Sage ERP Accpac Project and Job Costing, the P/M Inquiry screen displays a menu that provides access to customer or vendor transaction history. For customers, the menu also provides access to contract estimates and lists of contracts by status (for example, open, inactive, or completed).

If you use Sage ERP Accpac Return Material Authorization (RMA), the R/A Inquiry displays a menu allowing access to lists of active, completed, or all return authorizations.

On the R/A Inquiry screen for a customer, you can also create a return authorization. The R/A Inquiry tab for a vendor displays only those return authorizations with which the vendor has been associated.
Changes to Existing SageCRM Screens

The following SageCRM screens are modified during integration to provide additional features that enable further integration between SageCRM and Sage ERP Accpac.

- Company Summary
- Opportunity Summary

Company Summary

If you are viewing the Company Summary screen for an active customer, New Quote and New Order buttons appear on the right side of the screen.

When you click these buttons, SageCRM automatically creates a new opportunity for the current company, and then opens a new quote or order that is linked to the new opportunity.

Opportunity Summary

The Opportunity Summary screen displays detailed, up-to-date information about opportunity status, quote totals, and order totals. Any changes made to the opportunity will appear here, whether those changes are made in SageCRM or Sage ERP Accpac.

As you create quotes and orders for an opportunity, the Status field is updated automatically to reflect the current status of the opportunity. The following fields also display detailed information about the opportunity:

- **Forecast.** The current value of the opportunity.
- **Quote Amount.** The sum of all quotes included in the opportunity.
- **Pending Amount.** The sum of all quotes included in the opportunity but not yet promoted to an order.
- **Order Amount.** The sum of all orders for this opportunity that have not been shipped.
- **Shipment Amount.** The sum of all shipments for this opportunity that have not been invoiced.
- **Invoice Amount.** The sum of all invoiced shipments for this opportunity.

**Note:** Shipment and invoice amounts do not include any miscellaneous charge amounts added to the shipment or invoice.
Viewing Company and Opportunity Information

This section includes instructions for logging on to SageCRM, viewing company and opportunity screens, and viewing and modifying information and totals for companies and opportunities.

Logging On to SageCRM

If you are on the SageCRM server, click **Start > Programs > SageCRM > CRM** to log on. Otherwise, use the following procedure.

**To log on to SageCRM:**

1. Open an Internet Explorer browser window.
2. In the address bar, type the URL of the SageCRM installation.
   
   The URL depends on your computer name and install directory. For example, if your computer name is ACCPAC, and you installed SageCRM with the default installation name of CRM, type **http://ACCPAC/CRM**

   The Log On dialog box appears.
3. Type **admin** in the User Name field, and leave the Password field blank.
4. Click **Log On**.

   SageCRM displays the splash screen, or the My CRM work area.

Specifying the Number of Rows that Appear in the Grid

You can specify the number of rows displayed in the grid of any integrated Sage ERP Accpac screen, such as A/R unposted invoices.

**To specify the number of rows that appear in the grid:**

1. On the SageCRM Main Menu, click **My CRM**.
2. Click the **Preferences** tab.
3. In the **Grid Size** box, select the number of rows to display.

---

**Note:** To have access to My CRM, your User ID must be set up in the Users function to access My CRM Lists.
Viewing and Modifying Company Information

In SageCRM, you use the tabs at the top of the screen to navigate to different program screens. The tabs that appear depend on the current context. This section describes the Company context.

Viewing Company Tabs

When you select a company, SageCRM displays tabs that appear in the company context, including the Promote to Accpac tab and the different Inquiry tabs.

To view tabs in the Company context:

1. On the left sidebar, click **Find**.
2. On the Find list at the top of the screen, select **Company**.
   
   A list of all companies appears. You can further narrow your search by entering the Accpac Database ID, or an Accpac Customer or Vendor Number.

3. On the right sidebar, click **Find**.
4. Select the company you want to view from the alphabetized list.

   The Company Summary page appears and the Company (or Vendor) context tabs are displayed.

   **Note:** Changes made to the following fields on the Company Summary page in SageCRM are reflected in Accpac when you click Save:

   - Tax Group
   - Group Code
   - Description
   - Website
   - Terms Code
   - Address Fields
   - Business Phone, Fax and E-mail fields
   - Contact Information
   - Company Name
Specifying Sage ERP Accpac A/R and A/P Person and Address Types

The Person and Address edit screens include a series of check boxes that you can use to specify one or more types. When SageCRM is integrated with Sage ERP Accpac, new **Type** check boxes appear for contacts and addresses:

- If a person is a Sage ERP Accpac A/P Contact, A/P Remit-To Contact, A/R Contact, or A/R Ship-To Contact, their contact information is synchronized between SageCRM and Sage ERP Accpac. Within the context of a company, only one person can have the Accpac A/P or A/R Contact type selected. However, more than one person can be assigned as the Accpac A/P Remit-To Contact (or A/R Ship-To Contact).

- If an address is a Sage ERP Accpac A/P Address, A/P Remit-To Address, A/R Address, or A/R Ship-To Address, its information is synchronized with the address in the customer/vendor record.

- If an address is a Ship-To or Remit-To address, it is synchronized with A/R Ship-To or A/P Remit-To addresses. Within the context of a company, only one address can have the Accpac A/R or A/P Address type selected. However, more than address can be assigned as the Accpac A/P Remit-To Address (or A/R Ship-To Address).

**Note:** Ship-To and Remit-To addresses and contacts cannot be created in SageCRM. Use Sage ERP Accpac to create the addresses and contacts.
Viewing and Modifying Optional Fields

If you use optional fields in Sage ERP Accpac Accounts Receivable or Accounts Payable, you can use the Optional Fields screen to view and modify the optional fields for a customer or vendor.

To view optional fields for a company:

1. Select a customer or vendor.
2. Click the Optional Fields tab.

The Optional Fields screen appears and displays Sage ERP Accpac optional fields for the current company.

The screen displays all the optional fields defined for all customers (or vendors) for a company, as configured in the Optional Fields setup form in Sage ERP Accpac Accounts Receivable (or Accounts Payable).

The Value Set and Auto Insert values reflect the values set in Sage ERP Accpac. For descriptions of these fields, refer to the Sage ERP Accpac documentation.

The optional fields that apply to the current customer (or vendor) are selected in the Field Exists check box.

3. To edit optional fields, click Change in the right sidebar.

The check boxes are available.

- Enter (or edit) a value, and then select both Value Set and Field Exists.
Note: To save the value, you must select Value Set. You can clear the Value Set check box if the optional field has not been set up with a default value in Sage ERP Accpac. If it is cleared, the field’s value will also be cleared.

- You must select the Field Exists box to apply an optional field (including a blank optional field if allowed) to the customer (or vendor). If you clear the check box, the optional field no longer applies to the customer or vendor.

- The Auto Insert label next to the Field Exists check box appears only for fields with Auto Insert set to ‘Yes’ in Sage ERP Accpac, and is for display only. To change Auto Insert, use the Optional Fields setup form in Sage ERP Accpac Accounts Receivable or Accounts Payable.

- Enter any Date or Number optional field in the format defined on the Preferences tab of My CRM.

- Enter any Time optional field in the following format: hh:mm:ss.

- Changes you make on this screen will be reflected in Sage ERP Accpac records.

Viewing Customer and Vendor Aging and Statistical Information

You can view summary information for customers and vendors in the Company context from the Customer Statistics or Vendor Statistics tabs. These tabs are displayed only for companies with a Sage ERP Accpac customer or vendor number.

To view credit information for a company:

1. Select a company.

   The Company Summary tab opens.

2. Click the Customer Statistics or Vendor Statistics tab.

   The Customer Statistics or Vendor Statistics screen opens with Sage ERP Accpac credit information:
3. On the right sidebar, click **Customer Activity** or **Vendor Activity**.

   The Sage ERP Accpac A/R Customer Activity or Vendor Activity form appears.

On the Credit Information panel (top-left), you can:

- Click the **Customer Number** link to open the Sage ERP Accpac A/R Customers form (or for a vendor, click the **Vendor Number** link to open the Sage ERP Accpac A/P Vendors form).

- Click the **Optional Fields** link (where available) to view optional fields associated with the customer (or vendor).

- If the customer is set up with a Sage ERP Accpac A/R national account number, click the **National Account** link to open the Sage ERP Accpac A/R National Accounts form.

In the Aging panel at the top right, you can edit dates and values, and then click **Run Aging** in the right sidebar to recalculate the results.

The Document Totals panel displays total values for different types of transactions. When you change the Fiscal Year, Fiscal Period, or Currency Type, the details refresh automatically.

- The first column lists document types.
- The second column lists totals for the selected period.
- The third column lists totals for the selected year, up to and including the selected period.
- The fourth column lists totals for the year previous to the selected year.
Viewing Company and Opportunity Information

**Note:** You can display Documents Totals in either the customer/vendor currency or the functional currency.

The Document History panel shows statistics about the customer’s (or vendor’s) document history.

If the customer is set up with a Sage ERP Accpac A/R national account number, national account information also appears at the bottom of the screen.

**Viewing and Modifying Opportunity Information**

In SageCRM, you use the tabs at the top of the screen to navigate to different program screens. The tabs that appear depend on the current context. This section describes the Opportunity context.

**Viewing Opportunity Tabs**

When you select a company, SageCRM displays tabs that appear in the opportunity context. This is the context in which the Quotes and Orders tabs appear, allowing you to view, create, and edit Sage ERP Accpac quotes and orders.

**To view tabs in the Opportunity context:**

1. On the left sidebar, click **Find**.
2. On the Find list at the top of the screen, select **Company**. You can further narrow your search by entering criteria in the fields on the Find tab.
3. On the right sidebar, click **Find**.
4. Select the company you want to view from the alphabetized list.
5. Click the **Opportunities** tab.

The Opportunity Summary page appears, and the Opportunity context tabs are displayed.

**Viewing and Modifying Opportunity Stage and Status**

On the Opportunity Summary screen, you can view information about the current stage and status of an opportunity as it progresses through the sales cycle. This information is updated as changes are made in SageCRM and Sage ERP Accpac.

You can update the **Stage** and **Status** fields manually to show the current status of an opportunity, or if workflow is enabled, you can use the workflow bullets in the right sidebar to progress the opportunity.
After integration with Sage ERP Accpac, these fields are updated as follows when you create an opportunity, create quotes, promote quotes to an order, or save an order that completes the opportunity:

- **Create a new opportunity.** When you click **New Quote** or **New Order** on the Company Summary screen, SageCRM creates a new opportunity automatically. (You can create a new opportunity manually by right-clicking the **New** button on the right sidebar and selecting **Opportunity**.)
  - **Stage:** Lead
  - **Status:** In Progress

- **Create a new quote.** You can create a new quote by clicking **New Quote** on the Company Summary Screen or the Quotes tab (available when you are in the Opportunity context).
  - **Stage:** Proposal Submitted
  - **Status:** In Progress

- **Create a new order.** You can create a new order by clicking **New Order** on the Company Summary Screen or the Orders tab (available when you are in the Opportunity context).
  - **Stage:** Sale Agreed
  - **Status:** In Progress

- **Promote one or more quotes to an order.** On the Quotes tab (available when you are in the Opportunity context), you can select one or more quotes to promote to a Sage ERP Accpac O/E order. When you save the order, a message appears that allows you to complete the opportunity.

  If you do **not** complete the opportunity, you can continue to create quotes and orders linked to that opportunity, and the Stage and Status fields are updated as follows:
  - **Stage:** Sale Agreed
  - **Status:** In Progress

- **Complete an opportunity.** If you save an order and confirm that it completes the opportunity, the opportunity will be closed and you will not be able to create new quotes or orders without reopening it.
  - **Stage:** Sale Agreed
  - **Status:** Won
Viewing Opportunity Forecast and Totals

On the Status tab of the Opportunity Summary screen, the Forecast field shows the current value of an opportunity as it progresses through the sales cycle. This information is updated as changes are made in SageCRM and Sage ERP Accpac.

- If the opportunity has quotes but no orders, this field shows total quote value.
- If the opportunity has one or more orders and its status is In Progress, this field shows total order value plus the value of quotes not yet promoted to an order.
- For any opportunity status, the amount displayed in this field is always displays the sum of Pending, Order, Shipment, and Invoice amounts.

On the Opportunity Totals tab, the Amount fields show detailed information to help you track the opportunity as it progresses through the sales process.

**Note:** Amounts for a quote are only included in opportunity totals if the Include in Opportunity Totals option is selected for the quote.

This ensures that opportunity totals do not show artificially inflated amounts. For example, if you create multiple versions of a quote, you may want to include only the most recent version in opportunity totals.

- **Quote Amount.** The sum of all quotes included in the opportunity.
- **Pending Amount.** The sum of all quotes included in the opportunity but not yet promoted to an order.
- **Order Amount.** The sum of all orders for this opportunity that have not been shipped.
- **Shipment Amount.** The sum of all shipments for this opportunity that have not been invoiced.
- **Invoice Amount.** The sum of all invoiced shipments for this opportunity.

**Note:** Shipment and invoice amounts do not include any miscellaneous charge amounts added to the shipment or invoice.
Importing National Accounts

When you use the Sage Accpac Administration screen to import national accounts, SageCRM imports the National Account relationship from Sage ERP Accpac. You can view these relationships on the Relationships screen.

If you make any change to a customer’s national account membership in Sage ERP Accpac, the change will also appear in SageCRM.

The main national account office must be a customer with the same customer number as the national account.

For example, the sample company SAMINC includes a national account called BARMART. The main national account office is a customer with customer number = “BARMART”. There are two national account “children” (members): Barmart San Diego (Customer 1100) and Barmart Oakland (Customer 1105).

After you import national accounts into SageCRM, the following information will appear on the Relationships screen for the customer “BARMART”:

To see the “parent” national account for a customer, click on a national account member name.

To import a national account:

9. On the left sidebar, click **Sage Accpac Administration**.

   **Note:** This option only appears if you have administrative rights.

10. Click **Import National Accounts**.

11. Select a company and a range of relationships to import, or leave default settings in the **From** and **To** fields to import all relationships:
Changing Customer and Vendor Numbers

Changes and Copies from Sage ERP Accpac Customer Number Change and Sage ERP Accpac Vendor Number Change can be synchronized to SageCRM.

You can change a customer or vendor number in Sage ERP Accpac and see those changes reflected in SageCRM.

For example, if you use Customer Number Change to change a customer number to a new number, the customer number will also be updated to the new number in the SageCRM company record.

You can also copy a customer or vendor number in Sage ERP Accpac Customer Number Change and Sage ERP Accpac Vendor Number Change and see those changes reflected in SageCRM.

For example, if you use Customer Number Change to copy an existing customer number, both the original customer and the new copied customer will be available in SageCRM.

Note: The “combine” feature is not supported.

Promoting a Customer or Vendor to Sage ERP Accpac

Use the Promote to Accpac screen to promote a SageCRM company to a Sage ERP Accpac customer or vendor.

Promoting a Company

When you promote a company, SageCRM automatically checks to see if the company already exists in Sage ERP Accpac. If the company does not exist, you are prompted to add a unique Customer Number or Vendor Number and additional fields required by the Sage ERP Accpac system.
To promote a company:

1. On the left sidebar, click **Find**.

2. On the Find list, select **Company**. You can specify additional criteria in the fields on this screen to narrow your search.

3. On the right sidebar, click **Find**.

   A list of companies that match your search criteria appears.

4. Select the company you want to promote.

   The Company Summary screen appears.

5. Click the **Promote To Accpac** tab.

6. Select a Sage ERP Accpac company database and click **Promote to Customer** (or **Promote to Vendor**) on the right sidebar.

   Depending on your choice, the New Customer or New Vendor screen appears.

   **Note:** Fields marked with an asterisk are mandatory.

7. Enter company details for the company on each tab.

   **Note:** To change the tax class or set the tax status for the new customer or vendor, click **Show Tax Classes** on the right sidebar.

   You can select up to five salespersons and their sales split if you are promoting a company to customer.

   The Optional Field Values section displays all the optional fields defined for all customers (or vendors) in a company. Enter optional field information for a vendor or customer in this screen to apply options to the current customer or vendor.

8. On the right sidebar, click **Promote to Customer** (or **Promote to Vendor**).

   - The company is promoted to Customer or Vendor status, and company details are available in both SageCRM and Sage ERP Accpac.

   - Company type is set to Customer or Vendor, and the Customer Number, Credit Limit, Group Code, Tax Group and Terms Code fields are added to the screen. The Customer Type, Sage ERP Accpac Customer Number, and Credit Limit are read-only.
• The customer number of any opportunity-linked Order Entry quotes, orders, shipments, and invoices assigned to the company is updated to reflect the new customer number.

**Changing a Customer or Vendor Link**

If you have used the Import Customers or Import Vendors feature on the Sage Accpac Administration screen to import an existing customer or vendor into SageCRM from Sage ERP Accpac, the Sage Accpac Customer/Vendor Integration tab appears on the Promote To Accpac screen:

- You can click the Change Customer/Vendor Link button to change the Customer Number or Vendor Number.
- If you need to delete a customer or vendor in Sage ERP Accpac but keep the customer in SageCRM, you can click the Unlink this Customer/Vendor button to delete the existing Customer/Vendor Number.

**Creating and Working with O/E Quotes and Orders**

After integrating SageCRM with Sage ERP Accpac, you can view, edit, create, and save O/E quotes and orders in SageCRM without using Sage ERP Accpac forms.

LanPak licenses

You do not need a LanPak license to use the integrated SageCRM Quote and Order screens described in this section, which you can use to view, edit, create, and save O/E quotes and orders in SageCRM without opening Sage ERP Accpac forms.

You can also use the Sage ERP Accpac Inquiry screens described in the “Using Sage ERP Accpac Inquiry Features” section of this chapter, such as P/O Inquiry and R/A Inquiry, without a LanPak license. However, you do require a LanPak license to use any of the integrated Sage ERP Accpac forms that can be launched from the Inquiry screens, such as A/R Invoice Entry.
On entry and summary screens for quotes and orders, dates appear based on the format specified in the language settings for your browser. This means that dates on these screens may appear in a different format than dates on other SageCRM screens, where date formatting is based on your SageCRM preferences.

**To change browser language settings:**
1. In Internet Explorer, click **Tools > Internet Options**.
2. On the General tab, click **Languages**.
3. Click **Add**, and then select a language.
4. Save your settings.

The new language settings are applied, including date formatting if applicable.

**To specify date format in SageCRM:**
1. Right-click **My CRM**, and then select **Preferences**.
2. Click **Change**.
3. On the Date/Time Preferences tab, select a format from the **Date Format** list.
4. Click **Save**.

**Creating a New Quote**

In SageCRM, quotes are linked to sales opportunities. You can create a new Sage ERP Accpac O/E quote for a company, whether the company is a Sage ERP Accpac customer or a non-existent customer (a customer that exists in SageCRM but not in Sage ERP Accpac).

If you create a quote for a non-existent customer, SageCRM assigns the customer number CRM999999999 for the new quote. If the customer is promoted to Sage ERP Accpac at a later date (either in SageCRM or in Sage ERP Accpac), this number is changed to the new customer number assigned in Sage ERP Accpac.

**To create a quote for an existing opportunity:**
1. Select a company.
2. Click the **Opportunities** tab.
   - A list of opportunities for the selected company appears.
3. Select an opportunity.
The Opportunity Summary screen appears.

4. On the Opportunity Summary screen, click the Quotes tab.

The Quote Summary screen appears.

5. In the right sidebar, click **New Quote**.

The Quote Entry screen appears.

**Note:** If the company is not a Sage ERP Accpac A/R customer, and has not been linked to a Sage ERP Accpac database, you will be asked to select a Sage ERP Accpac database to which to link this company.

6. On the Document Details tab, select the **Include in Opportunity Totals** option if you want totals from this quote to be included in the amounts that appear on the Opportunity Summary and Quote Summary screens. If you are creating multiple versions of a quote, you may want to select this option for only one version.

7. On the Quote Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

8. On the Quote Details tab, enter line items to be included in the quote. Note the following considerations:

   - After you make **any** changes to a quote, you must click the **Refresh** button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of the changes you make will **not** be displayed in subtotals, order discounts, tax amounts, or quote totals until you click this button.

   - To change the order of columns that appear in the grid, click the **View** menu and then drag and drop items in the list that appears. The item at the top of the list will appear as the left-most column in the grid, and so on.

   - To add comments for customers, click the **Add Comments** link in the **Comments** column. Comments will appear on the printed version of the quote.

   - To add instructions for SageCRM and Sage ERP Accpac users, click the **Add Instructions** link in the **Instructions** column. Instructions will **not** appear on the printed version of the quote.

9. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.
Note: If you specify an order discount in the totals area, the discount applies only to the item subtotal and is not applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage ERP Accpac, select the Discount Miscellaneous Charges option on the Totals tab, and post the document.

10. When you have finished creating the quote, click the Save button in the right sidebar.

SageCRM creates the quote, links it to the currently selected opportunity, and displays the quote in read-only mode.

After creating the quote, you can:

- Click Edit to edit the quote.
- Click Print to print the quote.
- Click Continue to view the Quote Summary screen, which displays all quotes linked to the currently selected opportunity. On this screen, you can review existing quotes, create new quotes, or select one or more quotes to promote to a new Sage ERP Accpac O/E order.

To create a quote and link it to a new opportunity:

1. Select a company.
2. In the right sidebar, click New Quote.

Note: The New Quote button appears only if the company you selected is an active company.

Also, if the company is not a Sage ERP Accpac A/R customer and has not been linked to a Sage ERP Accpac database, you will be asked to select a Sage ERP Accpac database to which to link this company.

SageCRM creates the new opportunity automatically in the background, and the Quote Entry screen appears.

3. On the Document Details tab, select the Include in Opportunity Totals option if you want totals from this quote to be included in the amounts that appear on the Opportunity Summary and Quote Summary screens. If you are creating multiple versions of a quote, you may want to select this option for only one version.

4. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.
5. On the Quote Details tab, enter line items to be included in the quote.

**Note:** After you make *any* changes to a quote, you must click the **Refresh** button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of the changes you make will **not** be reflected in subtotals, order discounts, tax amounts, or quote totals until you click this button.

6. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

**Note:** If you specify an order discount in the totals area, the discount applies only to the item subtotal and is **not** applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage ERP Accpac, select the **Discount Miscellaneous Charges** option on the Totals tab, and post the document.

7. When you have finished creating the quote, click the **Save** button in the right sidebar. SageCRM creates the quote, links it to the new opportunity, and displays the quote in read-only mode.

After creating the quote, you can:

- Click **Edit** to edit the quote.
- Click **Print** to print the quote.
- Click **Delete** to delete the quote.
- Click **Continue** to view the Quote Summary screen, which displays all quotes linked to the new opportunity. On this screen, you can review existing quotes, create new quotes, or select one or more quotes to promote to a new Sage ERP Accpac O/E order.

**Viewing and Editing Existing Quotes**

On the Quote Summary screen, you can view information about existing quotes for an opportunity, including associated orders, expiration date, and whether each quote is included in totals for the currently selected opportunity.

You can click the document number for a quote to view additional details, and if the opportunity has not been completed or expired, you can edit quote details.
To view and edit quote details:

1. Select an opportunity.
2. Click the Quotes tab.
   
   The Quote Summary screen appears.
3. In the Document Number column, click a link.
   
   The quote you selected opens in read-only mode in the Quote Entry screen.
4. If the selected company is an active customer and the opportunity has not been completed, you can click the Edit button in the right sidebar to edit quote details.

   Note: After you make any changes to a quote, you must click the Refresh button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or quote totals until you click this button.
5. When you have finished editing, click Save to save your changes.

Promoting Quotes to an Order

In SageCRM, you can create a new Sage ERP Accpac O/E order by selecting one or more quotes you have created for an opportunity, and then promoting those quotes to a new order.

If you create a quote or an order for a non-existent customer (a customer that exists in SageCRM but not in Sage ERP Accpac), SageCRM assigns the customer number CRM999999999 to the new order. If the customer is promoted to Sage ERP Accpac at a later date, this number is changed to the new customer number assigned in Sage ERP Accpac.

   Note: For information about promoting a SageCRM customer to Sage ERP Accpac, see the previous section in this chapter, “Promoting a Customer or Vendor to Sage ERP Accpac.”

You cannot promote a quote to an order if any of the following conditions apply:

- The quote has expired
- The quote has already been promoted to an order
The opportunity is closed (in this case, no quotes linked to the opportunity can be promoted to an order unless you reopen the opportunity).

When you save the new order that is created from the quote or quotes you selected, a message asks if this order completes the opportunity. If you complete the opportunity:

- SageCRM sets the opportunity’s status to Won
- You cannot add new quotes to the opportunity unless you reopen it
- All promoted quotes are now included in opportunity totals, regardless of whether you selected the Include in Opportunity Totals option when creating or editing the quotes.
- All quotes that have not been promoted to an order will no longer be included in opportunity totals.

After you promote quotes to a new order, SageCRM updates the forecast and total amounts on the Quote Summary, Order Summary, and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.” All quotes that were promoted to create the order appear in the Associated Quotes column on the Orders tab.

**To promote one or more quotes to an order:**

1. Select an opportunity.
2. Click the Quotes tab.
   
   The Quote Summary screen appears.
3. In the left column, click one or more check boxes to select the quote or quotes you want to promote to an order.

   **Note:** You cannot select quotes that have expired, or quotes that have already been promoted to an order.
4. In the right sidebar, click Promote to Order.

   SageCRM creates a new O/E order from the quotes you selected. The order is added to the Sage ERP Accpac O/E system.

   If the company linked to the current opportunity is a Sage ERP Accpac O/E customer, the Sage ERP Accpac customer number appears automatically in the Customer Number field.

   If the company linked to the current opportunity is a non-existent customer (a customer that exists in SageCRM but not in Sage ERP
Accpac), SageCRM assigns the customer number CRM999999999 for the new order.

5. A message appears, asking if this order completes the opportunity.
   - If the opportunity is complete and you will not need to create any more quotes or orders for it, click Yes.
     
     SageCRM sets the opportunity’s status to Won and clears the Include in Opportunity Totals option for all quotes that were not promoted to an order. You cannot create new quotes or orders for the opportunity unless you reopen it.
   - If you may need to create more quotes or orders for the opportunity, click No.
     
     The opportunity’s status remains In Progress, and the Include in Opportunity Totals option is unchanged for any remaining quotes that have not been promoted to an order.

The new order appears in read-only mode in the Order Entry screen.

You can now:
   - Click Edit to edit order details.
   - Click Continue to view the Order Summary screen for the current opportunity.

Creating a New Order

You can create a new Sage ERP Accpac O/E order for a company, whether the company is a Sage ERP Accpac customer or a non-existent customer (a customer that exists in SageCRM but not in Sage ERP Accpac).

If you create an order for a non-existent customer, SageCRM assigns the customer number CRM999999999 for the new order. If the customer is promoted to Sage ERP Accpac at a later date (either in SageCRM or in Sage ERP Accpac), this number is changed to the new customer number assigned in Sage ERP Accpac.

For information about promoting a SageCRM customer to Sage ERP Accpac, see the previous section in this chapter, “Promoting a Customer or Vendor to Sage ERP Accpac.”

The following procedure describes creating a new order for an existing SageCRM opportunity. If you want to create a new order by promoting one or more existing quotes to an order, see the previous section, "Promoting Quotes to an Order." If you want to create a new order and link it to a new opportunity, see the next procedure in this section.
To create a new order for an existing opportunity:

1. Select a company.

2. Click the Opportunities tab.
   
   A list of opportunities for the selected company appears.

3. Select an opportunity.
   
   The Opportunity Summary screen appears.

4. On the Opportunity Summary screen, click the Orders tab.
   
   The Order Summary screen appears.

5. In the right sidebar, click **New Order**.
   
   The Order Entry screen appears.

   **Note:** If the company is not a Sage ERP Accpac A/R customer, and has not been linked to a Sage ERP Accpac database, you will be asked to select a Sage ERP Accpac database to which to link this company.

6. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

7. On the Order Details tab, enter line items to be included in the order.
   
   Note the following considerations:

   - After you make any changes to an order, you must click the **Refresh** button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.

   - To change the order of columns that appear in the grid, click the **View** menu and then drag and drop items in the list that appears. The item at the top of the list will appear as the left-most column in the grid, and so on.

   - To add comments for customers, click the **Add Comments** link in the **Comments** column. Comments will appear on the printed version of the order.

   - To add instructions for SageCRM and Sage ERP Accpac users, click the **Add Instructions** link in the **Instructions** column. Instructions will not appear on the printed version of the order.
8. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

**Note:** If you specify an order discount in the totals area, the discount applies only to the item subtotal and is *not* applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage ERP Accpac, select the **Discount Miscellaneous Charges** option on the Totals tab, and post the document.

9. When you have finished creating the order, click the **Save** button in the right sidebar.

SageCRM displays the order in read-only mode, saves the order in SageCRM and Sage ERP Accpac, and updates the forecast and total amounts on the Order Summary and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.”

After creating the order, you can:

- Click **Edit** to edit the order.
- Click **Print** to print the order.
- Click **Delete** to delete the order.
- Click **Continue** to view the Order Summary screen, which displays all orders linked to the new opportunity.

**To create a new order and link it to a new opportunity:**

1. Select a company.

   The Company Summary screen appears.

2. In the right sidebar, click **New Order**.

   SageCRM automatically creates a new opportunity in the background, and then creates the order and links it to the new opportunity. The order appears in the **Order Entry** screen.

   If the company is a Sage ERP Accpac A/R customer, the Sage ERP Accpac customer number is added automatically to the Customer Number field in Sage ERP Accpac.

   If the company is a non-existent customer (a customer that exists in SageCRM but not in Sage ERP Accpac) and has not been linked to a
Sage ERP Accpac database, SageCRM asks you to link the company to a Sage ERP Accpac database.

3. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

4. On the Order Details tab, enter line items to be included in the quote.

   **Note:** After you make any changes to an order, you must click the Refresh button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.

5. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

   **Note:** If you specify an order discount in the totals area, the discount applies only to the item subtotal and is not applied to any miscellaneous charges.

   If you want to apply an order discount to miscellaneous charges, open the document in Sage ERP Accpac, select the **Discount Miscellaneous Charges** option on the Totals tab, and post the document.

6. When you have finished creating the order, click the **Save** button in the right sidebar.

SageCRM displays the order in read-only mode, saves the order in SageCRM and Sage ERP Accpac, and updates the forecast and total amounts on the Order Summary and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.”

After creating the order, you can:

- Click **Edit** to edit the order.
- Click **Print** to print the order.
- Click **Delete** to delete the order.
- Click **Continue** to view the Order Summary screen, which displays all orders linked to the new opportunity.
Viewing and Editing Existing Orders

If Sage ERP Accpac O/E orders exist for a company and are linked to a SageCRM opportunity, you can view and edit those orders in SageCRM.

To view and edit an order:

1. Select an opportunity.
2. Click the **Orders** tab.
   
   The Order Summary screen appears.
3. Click the linked number in the **Document Number** column.

   The order appears in the Order Entry screen.
4. In the right sidebar, click **Edit**.

   **Note:** After you make any changes to an order, you must click the **Refresh** button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.
5. Edit the order as needed, and when finished, click **Save**.

SageCRM and Sage ERP Accpac are updated with the new information for the order.

Using Sage ERP Accpac Inquiry

After integration, Sage ERP Accpac Inquiry tabs appear in SageCRM when you are in the Company context (after you select a company). You can use these screens to review information and perform a wide variety of tasks that use information from the Sage ERP Accpac system.

**Note:** These screens include many features that open integrated Sage ERP Accpac forms. For example, the A/R Inquiry and O/E Inquiry screens include buttons and links that open Sage ERP Accpac forms.

To open integrated Sage ERP Accpac forms, you need a LanPak license. However, you do not need a LanPak license to use the integrated Quote and Order screens in SageCRM.

To view Inquiry screens:

1. On the left sidebar, click **Find**.
2. On the **Find** list at the top of the screen, select **Company**. You can specify additional criteria in the fields on this screen to narrow your search.

3. On the right sidebar, click **Find**.

   A list of companies that match your search criteria appears.

6. Select the company you want to view from the alphabetized list.


7. Click an Inquiry tab for a list of the information you can view.

### Order Entry (O/E) Inquiry

You can view and modify Order Entry documents within the context of a customer from the O/E Inquiry tab. This tab appears only for companies with a Sage ERP Accpac customer number.

### Viewing, Modifying, or Creating Order Entry Transactions

On the O/E Inquiry screen, you can view, modify or create customer orders, shipments or invoices.

When you select **All Orders**, the Transactions screen appears with a list of orders for the current customer.

**Note:** You can use the Filter tab to refine the list of orders on this page.

### To create a new order from the Transactions page:

1. On the right sidebar, click **New**.

2. The Sage ERP Accpac O/E (or P/O) Order Entry form opens.

3. Complete the form.

4. Click **Add**.

To edit or view an order in the list, click the Order Number link. This opens the Sage ERP Accpac O/E Order Entry form in a new window.
Drill Down

To view an order in more detail, click its **Drill Down** button. This opens the Order Detail form.

The Order Detail form consists of these sections:

- The **Order Information** section displays order header information, such as order total and order date.
- The **Order Details** section (line items) appears below the order header.
• The Shipments section (if any) shows all shipping information for the order.

**Note:** On a vendor’s Purchase Order Detail form, a Receipts section appears (if it exists) instead of a Shipments section.

On the Order Detail form, you can do the following:

• To display a form with ship-to and bill-to address information, click the **Shipping & Billing Addresses** button.

• To create a new shipment record, click the **New Shipment** button. This opens the Sage ERP Accpac O/E Shipment Entry form in a new window.

• To edit or view the order, click the **Edit** button or the **Order Number** link in the Order Information (header) section of the Order Detail form. This opens the Sage ERP Accpac O/E Order Entry form in a new window.

• Click **Sales Split** in the right sidebar to display the sales persons and their sales split percentages for the transaction.

• Click the **Optional Fields** link (where available) on the order header to view the optional fields associated with the order. You cannot edit the fields.

```markdown
<table>
<thead>
<tr>
<th>Optional Field</th>
<th>Value</th>
<th>Optional Field Description</th>
<th>Value</th>
<th>Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Yes</td>
<td>AC#</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>APPROVED</td>
<td>Yes</td>
<td>Approved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COURIER</td>
<td>Yes</td>
<td>Courier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CREDITWILLING</td>
<td>Yes</td>
<td>Customer Credit Warning</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>MAXORDER</td>
<td>Yes</td>
<td>Maximum Order Amount</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>NOTE</td>
<td>Yes</td>
<td>Note</td>
<td></td>
<td>Allow greater volume discount</td>
</tr>
<tr>
<td>ORDERDATE</td>
<td>Yes</td>
<td>Order Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PREFERENCE</td>
<td>Yes</td>
<td>Preferred Customer</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>TEMPORARY</td>
<td>Yes</td>
<td>Temporary Customer</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>UPSZONE</td>
<td>Yes</td>
<td>UPS Zone</td>
<td>BM</td>
<td>White Zone</td>
</tr>
<tr>
<td>USER</td>
<td>Yes</td>
<td>User</td>
<td>ADMIN</td>
<td></td>
</tr>
<tr>
<td>WARRANTY</td>
<td>Yes</td>
<td>Warranty</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WAREHOUSE</td>
<td>Yes</td>
<td>WareHouse</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Click any active link in the Optional Fields column of the Order Detail form to view the optional fields for the order detail line.
• To view more details about a location listed on the Order Detail form, select a link in the Location column. Details appear in the Location Information tab:

![Location Information](image)

• Click any active link in the **Item** column of the Order Detail form to open the Item Detail form. This form shows general information about the item, as well as its details at each inventory location.

• To view detailed information regarding serial and lot numbers, click the link on the detail line (where available). This displays serial and lot information for the detail line.

**Note:** An asterisk (*) indicates the location (or bill of materials or kit) associated with the item. For example, if you are viewing a customer’s sales order, an asterisk indicates the location from which the item is shipped.

Open the Item Detail form by clicking the **Item Number** link. In the top section of the Item Detail form, you can click links to more detailed information, such as:

- **Alternate Item Number (if available).** If you click this link, the alternate item number value moves to the Item Number field and the form displays information about the alternate item number.

- **Optional Fields.** This link displays more details about the item’s optional fields.
In the lower section of the Item Detail form, you can click any of the links to view details of the item at a specific location, such as:

- **(Location) Name.** This link displays more information about a location, such as its address and contact information.

- **Quantity on S/O (if not zero).** This column shows the total quantity of the item that’s entered on all sales orders for the selected location. If you click a link in this column, then you can view a list of all the sales orders that contain the item at that location:

- **Quantity on P/O (if not zero).** This column shows the total quantity of the item that’s entered on all purchase orders for the selected location. If you click a link in this column, then you can view a list of all the purchase orders that contain the item at that location:

  You can click any of the links to obtain more details.

  9. If the Order Detail form you are viewing contains a Shipment section, you can:

  - Click the **Shipment Number** link to view the shipment details as entered in the Sage ERP Accpac O/E Shipment Entry form.
  
  - Click the **Drill Down** button to view a shipment’s details.

  The Shipment Detail form appears. The Shipment Information section shows you the shipment’s header information. The Shipment Details (line items) section appears below the shipment header. The Invoices section shows all of the Order Entry invoices generated from the shipment.
In the Shipment Information (header) section of the form, you can:

- Click the **Shipping & Billing Addresses** button to view the addresses.
- Click the **Edit** button, or the **Shipment Number** link, to view or edit the details in the Sage ERP Accpac O/E Shipment Entry form. You can edit the shipment details only if the shipment is not yet completed.
- Click the **New Invoice** button to open the Sage ERP Accpac O/E Invoice Entry form. You can create an invoice only if the shipment is not yet completed.
- Click the **Customer Number** link to view or edit the customer details in the Sage ERP Accpac A/R Customers form.
- Click the **Optional Fields** link (in the header section of the form) to view the shipment’s optional fields.

In the Shipment Details section, you can:

- Click an **Item** link to open the Item Detail form.
- Click a **Location** link to open the Location Information form, which was described earlier.
- Click an **Order Number** link to view the order details in the Sage ERP Accpac O/E Order Entry form.
- Click the **Serial or Lot Numbers** link (where available) to view detailed information about serial or lot numbers for the transaction.

In the Invoices section you can:
- Click an **Invoice Number** link to view the invoice details in the Sage ERP Accpac O/E Invoice Entry form.

- Click the **Drill Down** button to view an invoice’s details. The Invoice Detail form appears. Invoice Information shows you the Order Entry invoice header information. The line items appear below the invoice header.

- Click **Shipping & Billing Addresses** in the right sidebar to view the addresses.

- Click **Edit** in the right sidebar or the **Invoice Number** link to view or edit the invoice. This opens the Sage ERP Accpac O/E Invoice Entry form.

- Click any link to view more information. For example, in the Invoice Information (header) section, you can click the **Location** link to view location information.

In the Invoice Details grid, you can:

- Click the following links (where available): **Item**, **Location**, **Shipment Number** (opens the Sage ERP Accpac O/E Shipment Entry form), and **Optional Fields**.

- Click the **Serial or Lot Numbers** links (where available) to view detailed information about serial and lot numbers for the transaction.

For vendors: Receipt details

10. If you are viewing a vendor’s Purchase Order Detail form, you can drill down to the Receipt Detail form (instead of the Shipment Detail form), by clicking the **Receipt Number** link. The Receipt Detail form looks similar to the Shipment Detail form, with a header information section, item list, and invoices.

You can also:

- Drill down to any invoices for the receipt from the Receipt Information screen.
• Create a new receipt from the Purchase Order information screen or a new invoice from the Receipt Information screen:

![Receipt Information](image)

- Click **Edit** in the right sidebar or the Receipt Number link to edit the receipt.
- Click the **Serial or Lot Numbers** links (where available) to view detailed information about serial and lot numbers for the transaction.
- Click any link on the form to view or edit information.

### Creating a New Sales Order

**To create a new sales order:**

1. On the O/E Inquiry tab, click **New Order**.
   
   The SageCRM Order screen appears.

2. Complete the form.

3. Click **Post**.

**Tip:** You can create new orders, shipments, and invoices from the Drill Down screens for each of these transactions. For example, you can create a new shipment from the order Drill Down, or a new invoice from the shipment Drill Down.
**Viewing Credit/Debit Notes**

**To view credit/debit notes:**

1. Click the customer’s O/E Inquiry tab.

2. Select the **Credit/Debit Note** option. A list of credit/debit notes appears, if any.

3. To refine your list of orders displayed, you can choose to display only the orders that fall within the range of dates that you specify.

4. To create a credit or debit note, click **New** in the right sidebar.

5. To view or edit the credit or debit note, click the **Credit/Debit Note Number** link. This opens the Sage ERP Accpac Credit/Debit Note Entry form.

6. Click the **Drill Down** icon to view a summary of the credit or debit note.

You can use the following features on this screen.

- Click **Edit** or the **Credit/Debit** link to view or edit the credit or debit note. This opens the Sage ERP Accpac O/E Credit/Debit Note Entry form.

- Click any active link to view more details.

- For example, in the header section of the form, you can click the **Optional Fields** link (where available) to view optional fields for the overall credit/debit note. To view optional fields for the credit/debit detail line, click any **Yes** link in the Optional Fields column.
In the detail section of the form, you can click the Item or Location link.

**Viewing All Shipments**

You can view all Sage ERP Accpac O/E shipments, including those which do not have a corresponding order.

**To view all shipments:**

- On the O/E Inquiry screen, click All Shipments.

A list of all shipments appears:

Use the following features on this screen:

- **Filter.** Enter search criteria into the Filter tab to see specific shipments. Click Filter in the right sidebar.

- **Shipment Number.** Click the Shipment Number link to view details about the shipment number.

- **Drill Down.** Click the Drill Down icon to view detailed information for the shipment (or receipt). The Shipment Detail form opens.

  Click any link in the Drill Down form to view more detailed information about the shipment (or receipt).

  You can also create or view any invoices for each shipment from the shipment drill down.

**Viewing Pending Shipments**

You can view O/E Orders with pending shipments on the O/E Inquiry screen.

**To view O/E pending shipments:**

- On the O/E Inquiry screen, click Pending Shipments.
A list of pending shipments for the current customer appears.

You can use the following features on this screen:

**Filter.** To refine your list of displayed pending shipments, enter search criteria and click **Filter** in the right sidebar. For example:

- You can choose to display only the pending shipments that fall within the range of expected shipment dates, item numbers, or locations that you specify.

  **Note:** Filtering is done on a “per detail line” basis. For example, an order will be displayed in the list if one of its detail lines has an expected shipment date that falls within the specified expected shipment date range.

- In the **Order Type** field, you can choose the type of orders to display, or choose to display all orders.

**Order Number.** To edit an order in the list, click its **Order Number** link. This opens the Sage ERP Accpac Order Entry form in a new window.

**Drill Down.** To view an order in more detail, click the **Drill Down** button for the order. This opens the Order Detail form.
Click any active link to view more details. For example:

- Click the Optional Fields link (where available), to view optional fields for the overall order. You can also click the Order Number link and Customer link to view information on the Sage ERP Accpac forms.
- To display more information about an item or the location, click the link in the Item column or the Location column.
- In the On Purchase Order column, you can click any Yes link to view all the purchase orders that contain the item.

**Viewing Item Sales History**

To view item sales history:

1. Click the **O/E Inquiry** tab.
2. Select the Sales History option.
3. Specify filter criteria for the Item Sales you want to see.
4. In the right sidebar, click **Filter**.

If there are sold items that match your criteria, a list appears below the Filter tab.
5. Click any active link to view more details. For example, click the link in an item’s Period column to display sales history detail of the item during the selected period.

Click any active link on this form to display more information. For example, click the Trans. Number link or the Order Number link to open the associated Sage ERP Accpac Order Entry forms.

Click the Serial or Lot Numbers link (where available) to view detailed information about serial and lot numbers for this transaction.

Note: For O/E invoices and all P/O transactions which were upgraded from previous Accpac versions, the serial and lot numbers links will display as “No” and will not be active.

**Viewing Customer Price List**

This section describes the forms and procedures for the O/E Customer Price List option of the O/E Inquiry screen. The list displays item pricing information for items that are priced using the customer’s default price list.

You can click the Drill Down icon to display all pricing information including sale pricing and how discounts are calculated.
To view customer price list:

1. On the O/E Inquiry screen, click **Customer Price List**.

2. The customer price list appears and displays information including the current base price and sale price based on the customer’s default price list.

You can now:

- Click the **Item Number** link to view details about the item.
- Click the **Drill Down** icon to view detailed pricing information.

Viewing Serial and Lot Number Sales History

This section describes the forms and procedures for the O/E Serial and Lot Number Sales History options of the O/E Inquiry screen.

The Serial and Lot Numbers menu displays transactions and transaction details for customer transactions with serials and lots.

To view serial and lot number sales history:

- On the O/E Inquiry screen, click Serial Number Sales History or Lot Number Sales History.
The Sales History screen appears.

You can now:

- **Filter.** Enter search criteria to refine the list of transactions displayed. Click **Filter** in the right sidebar.

- **Drill Down.** Click the **Drill Down** icon to view detailed information about the transaction.

**Purchase Orders (P/O) Inquiry**

You can view and modify Purchase Order documents from the P/O Inquiry screen within the context of a vendor. This tab appears only for companies with a Sage ERP Accpac vendor number.

**Creating a New Purchase Order**

**To create a new purchase order:**

1. On the P/O Inquiry tab, select **New Purchase Order**.
   The SageCRM Purchase Order Entry screen appears.

2. Complete the form.

3. Click **Post**.

**Tip:** You can create new orders, shipments, and invoices from the Drill Down screens for each of these transactions. For example, you can create a new shipment from the order Drill Down, or a new invoice from the shipment Drill Down.
Viewing Credit/Debit Notes

To view credit/debit notes:

1. Click a vendor’s P/O Inquiry tab.

2. Select the Credit/Debit Note option. A list of credit/debit notes appears, if available.

3. To refine your list of orders displayed, you can choose to display only the orders that fall within the range of dates that you specify.

4. To create a credit or debit note, click **New** in the right sidebar.

5. To view or edit the credit or debit note, click the **Credit/Debit Note Number** link. This opens the Sage ERP Accpac Credit/Debit Note Entry form.

6. Click the **Drill Down** icon to view a summary of the credit or debit note.

You can use the following features on this screen:

- Click **Edit** or the **Credit/Debit** link to view or edit the credit or debit note. This opens the Sage ERP Accpac O/E Credit/Debit Note Entry form.

- Click any active link to view more details.

- For example, in the header section of the form, you can click the **Optional Fields** link (where available) to view optional fields for the overall credit/debit note. To view optional fields for the credit/debit detail line, click any **Yes** link in the Optional Fields column.
In the detail section of the form, you can click the **Item** or **Location** link.

**Viewing All Receipts**

This section describes the forms and procedures for the P/O All Receipts option of the P/O Inquiry screen.

**To view all receipts:**

- On the O/E Inquiry screen, click **All Receipts**.

A list of all receipts appears.

You can use the following features on this screen:

- **Filter.** Enter search criteria into the Filter tab to see specific shipments. Click Filter in the right sidebar.

- **Shipment Number.** Click the Shipment Number link to view details about the shipment number.

- **Drill Down.** Click the drill down icon to view detailed information for the shipment (or receipt). The Shipment Detail form opens.

  Click any link in the Drill Down form to view more detailed information about the shipment (or receipt).

  You can also create or view any invoices for each shipment from the shipment drill down.

**Viewing Pending Receipts**

This section describes the forms and procedures for the P/O Pending Receipts option of the P/O Inquiry screen.

**To view pending receipts:**

- On the O/E Inquiry screen, click **Pending Shipments**.
A list of pending shipments for the current customer is displayed.

You can use the following features on this screen:

**Filter.** To refine your list of displayed pending shipments, enter search criteria and click **Filter** on the right sidebar. For example:

- You can choose to display only the pending shipments that fall within the range of expected shipment dates, item numbers, or locations that you specify.

  **Note:** Filtering is done on a “per detail line” basis. For example, an order will be displayed in the list if one of its detail lines has an expected shipment date that falls within the specified expected shipment date range.

- In the Order Type field, you can choose the type of orders to display, or choose to display all orders.

**Order Number.** To edit an order in the list, select its Order Number link. This opens the Sage ERP Accpac Order Entry form in a new window.

**Drill Down.** To view an order in more detail, select the Drill Down button for the order. This opens the Order Detail form.
Click any active link to view more details. For example:

- Click the **Optional Fields** link (where available), to view optional fields for the overall order. You can also click the **Order Number** link and **Customer** link to view information on the Sage ERP Accpac forms.

- To display more information about an item or the location, click the link in the **Item** column or the **Location** column.

- In the **On Purchase Order** column, you can click any **Yes** link to view all the purchase orders that contain the item.

**Viewing Purchase History**

**To view purchase history:**

1. Click the P/O Inquiry tab.

2. Select the **Purchase History** option.

3. Specify filter criteria for Purchase History items you want to see.

4. In the right sidebar, click **Filter**.

If purchased items exist that match the criteria you specified, a list appears below the Filter section.
5. Click any active link to view more details. For example, click the link in an item’s **Period** column to display sales history detail of the item during the selected period.

Click any active link on this form to display more information. For example, click the **Trans. Number** link or the **Order Number** link to open the associated Sage ERP Accpac Order Entry forms.

Click the **Serial or Lot Numbers** link (where available) to view detailed information about serial and lot numbers for this transaction.

**Note:** For O/E invoices and all P/O transactions which were upgraded from previous Sage ERP Accpac versions, the serial and lot numbers links will display as “No” and will not be active.

**Viewing Vendor Contract Costs**

This section describes the forms and procedures for the P/O Vendor Contract Costs option of the P/O Inquiry screen. The list displays item pricing information for items which are priced using the vendor’s default price list.

Click the **Drill Down** icon to display all pricing information including how discounts are calculated, sale pricing, and contract pricing.
To view vendor contract costs:


2. The vendor contract costs appear with information including the current base price and sale price based on the vendor’s default price list.

You can now:

- Click the Item Number link to view details about the item.
- Click the Drill Down icon to view detailed pricing information.

Viewing Serial and Lot Number Purchase History

This section describes the forms and procedures for the P/O Serial and Lot Number Purchase History options of the P/O Inquiry screen.

To view serial and lot number purchase history

- On the O/E Inquiry screen, click Serial Number Purchase History or Lot Number Purchase History.

The serial or lot number sales history screen is displayed.
You can now:

- **Filter.** Enter search criteria to refine the list of transactions displayed. Click **Filter** in the right sidebar.

- **Drill Down.** Click the **Drill Down** icon to view detailed information about the transaction.

### Viewing or Editing Requisitions

**To view or edit requisitions:**

- On the P/O Inquiry screen, click Requisitions.

A list of requisitions for the current vendor appears.

You can use the following features on this screen:

**Filter.** To refine your list of documents displayed, enter search criteria and click **Filter** in the right sidebar. For example:

- To include completed documents in the list, select the **Include Completed Transactions** check box.

- You can choose to display only the requisitions that fall within the range of dates that you specify.

**New.** Click **New** in the right sidebar to create a new requisition. This opens the Sage ERP Accpac P/O Requisition Entry form in a new window. Complete the form and click **Add**.

**Requisition Number.** To edit or view a requisition in the list, click this link. This opens the Sage ERP Accpac P/O Requisition Entry form in a new window.

**Drill Down.** To view a requisition in more detail, click its **Drill Down** button. This opens the following form:
Using Sage ERP Accpac Inquiry

On the Requisition Information tab:

- To edit or view the requisition, click **Edit** in the right sidebar or the **Requisition Number** link. This opens the Sage ERP Accpac P/O Requisition Entry form in a new window.

- To view vendor details, click the **Vendor** link to open the Sage ERP Accpac A/P Vendors form in a new window.

- Click the **Optional Fields** link (where available) to view optional fields information.

On the **Requisition Lines** tab, click any link to view more information. For example:

- To view vendor details, click the **Vendor** link in the grid to open the Sage ERP Accpac A/P Vendors form in a new window.

- To view more details about an item number or location, click its link.

**Viewing or Editing Returns**

**To view or edit returns:**

- On the P/O Inquiry screen, click Returns.

A list of returns for the current vendor appears.
You can use the following features on this screen:

**Filter.** To refine your list of documents displayed, enter the fields in the Filter section, and click the Filter button. For example:

- To include completed documents in the list, select **Include Completed Transactions**.
- You can choose to display only the returns that fall within the range of dates that you specify.

**New.** Click **New** in the right sidebar to create a new return. This opens the Sage ERP Accpac P/O Return Entry form in a new window. Complete the form and click **Post**.

**Return Number.** To edit or view a return in the list, click this link. This opens the Sage ERP Accpac P/O Return Entry form in a new window.

**Drill Down.** Click the **Drill Down** icon to view a return in more detail. This opens the following form:

<table>
<thead>
<tr>
<th>Return Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Number</td>
</tr>
<tr>
<td>Vendor</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Reference</td>
</tr>
<tr>
<td>Ship-To</td>
</tr>
<tr>
<td>Ship-To Name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Return Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Cost</td>
</tr>
<tr>
<td>Discount Amount</td>
</tr>
<tr>
<td>Net Return Cost</td>
</tr>
<tr>
<td>Tax Included</td>
</tr>
<tr>
<td>Tax Included</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

On the **Return Information** tab:

- Click **Shipping & Billing Addresses** in the right sidebar to view the addresses.
- Click **Edit** or the **Return Number** link to view or edit the return. This opens the Sage ERP Accpac P/O Return Entry form in a new window.
- Click the **Vendor** link to view vendor details. This opens the Sage ERP Accpac A/P Vendors form in a new window.
- Click the **Optional Fields** link (where available) to view optional fields information.

On the **Return Lines** tab, click any link to view more information, such as the **Item Number** link or **Location** link.
Accounts Receivable (A/R) and Accounts Payable (A/P) Inquiry

From the A/R Inquiry or A/P Inquiry screens, you can choose to display a list of posted documents or a list of unposted Accounts Receivable or Accounts Payable documents.

The procedures that follow describe A/R Inquiry features. The A/P Inquiry screen functions are similar, so you can also follow these procedures when you use A/P Inquiry.

Viewing Posted Transactions

To view posted transactions:

- On the A/R Inquiry screen, click Posted Transactions.

A list of posted Sage ERP Accpac A/R documents (such as invoices, receipts, refunds, and so on) appears for the currently displayed customer.

You can use the following features on this form:

Filter. Enter filtering criteria to refine the list of documents displayed. Click Filter in the right sidebar.

New Invoice / Receipt / Refund. To create a new Sage ERP Accpac A/R document, select one of the following choices from the right sidebar: New Invoice, New Receipt, or New Refund. Each choice opens the appropriate Sage ERP Accpac Accounts Receivable form in a new window.

Document Number link. To edit or view the details of a document, click the Document Number link. This opens the document in the Sage ERP Accpac A/R form.

Applied Details. To view a list of documents that have been applied to a given document, select the document’s Applied Details button. The Applied Details form appears.
You can click the **Reference Document No.** link to view the document details on the Sage ERP Accpac A/R form.

**Drill Down.** To view a document in more detail, select its Drill Down button. The Document Details form is displayed.

The top portion of the form displays the document header information. The detail lines appear below the document header. All documents that have been applied to the document appear below the detail lines.

On this form you can:

- Click **Edit** or **New** on the right sidebar to edit or create a document. Either choice opens the associated Sage ERP Accpac A/R (or A/P) form.

- Click the **Optional Fields** link (where available), to view optional fields associated with the overall document. You can also click the **Document Number** link to open the document in the Sage ERP Accpac A/R (or A/P) form.

**Viewing Unposted Invoices**

**To view unposted invoices:**

- On the A/R Inquiry screen, click **Unposted Invoices**.

A list of unposted A/R invoices appears for the currently displayed customer.

You can use the following features on this form:

**New.** Click **New** on the right sidebar to create a new Sage ERP Accpac A/R invoice. This opens the Sage ERP Accpac A/R Invoice Entry form.

**Document Number.** Click the **Document Number** link to edit or view the details of a document. The Sage ERP Accpac A/R Invoice Entry form appears.

**Drill Down.** To view a document in more detail, select its Drill Down button. The Document Details form appears.
You can use the following features on this form:

- **New.** Click New on the right sidebar to create a new Sage ERP Accpac A/R invoice. This opens the Sage ERP Accpac A/R Invoice Entry form.

- **Edit or view document.** Click Edit in the right sidebar or the Document Number link to edit or view the details of a document. This opens the document in the Sage ERP Accpac A/R form.

- **Optional Fields** Click the Optional Fields link (where available) to display optional fields information.

### Viewing Unposted Receipts

**To view unposted receipts:**

- On the A/R Inquiry screen, click **Unposted Receipts**.

A list of unposted A/R receipts appears for the currently displayed customer.

You can use the following features on this form:

**New.** Click New in the right sidebar to create a new Sage ERP Accpac A/R receipt. This opens the Sage ERP Accpac A/R Receipt Entry form.

**Edit or view document.** Click the Check/Receipt No. link to edit or view the details of a document. This opens the document in the Sage ERP Accpac A/R Receipt Entry form.

**Drill Down.** Click the Drill Down icon to view a document in more detail. The Document Details form is displayed.
You can use the following features on this form:

- **New.** Click **New** in the right sidebar to create a new Sage ERP Accpac A/R receipt. This opens the Sage ERP Accpac A/R Receipt Entry form.

- **Edit or view document.** Click **Edit** in the right sidebar or the Document Number link to edit or view the details of a document. This opens the document in the Sage ERP Accpac A/R form.

- **Optional Fields.** Click the **Optional Fields** link (where available) to display optional fields information.

### Viewing Unposted Refunds

**To view unposted refunds:**

- On the A/R Inquiry screen, select Unposted Refunds.

A list of unposted A/R refunds appears for the currently displayed customer.

You can use the following features on this form:

**New.** Click **New** on the right sidebar to create a new Sage ERP Accpac A/R refund. This opens the Sage ERP Accpac A/R Refund Entry form.

**Edit or view document.** Click the **Document Number** link to edit or view the details of a document. This opens the document in the Sage ERP Accpac A/R Refund Entry form.

**Drill Down.** Click the **Drill Down** icon to view a document in more detail. The Document Details form appears.
You can use the following features on this form:

- **New.** Click **New** in the right sidebar to create a new Sage ERP Accpac A/R refund. This opens the Sage ERP Accpac A/R Refund Entry form.

- **Edit or view document.** Click **Edit** in the right sidebar or the **Document Number** link to edit or view the details of a document. This opens the document in the Sage ERP Accpac A/R form.

- **Optional Fields.** Click the **Optional Fields** link (where available) to display optional fields information.

**Project and Job Costing (P/M) Inquiry**

If you use Sage ERP Accpac Project and Job Costing, you can view or modify Project and Job Costing contracts within the context of a company from the P/M Inquiry screen.

For a customer, the P/M Inquiry screen displays the following options:

For a vendor, the P/M Inquiry screen displays only the **Transaction History** option.

**Creating a New Contract**

To create a new contract:

1. Select a customer.
2. On the P/M Inquiry tab, click **New Contract**.
3. Complete the form.
4. Click **Add**.
Viewing and Editing Contracts

To view and edit contracts:

- On the P/M Inquiry screen, click **All Contracts**.

A list appears with all contracts for a customer:

![Image of Contracts List]

Notes:

- If a contract does not have any projects, then the contract will not appear in the list.

- If a contract does not have any projects set for the contract customer, then the contract will not appear in the list.

- If a contract has projects that have been assigned multiple customers, you will see that contract displayed in the list when you choose to view all contracts for any of the associated customers.

You can do the following on this form:

- To refine the list of contracts displayed, enter search criteria in the filter and click **Filter** in the right sidebar. For example, you can choose to display only the documents that fit the contract status you specify, or that fall within the range of dates that you specify.

- Click **New** on the right sidebar to create a contract. This opens the Contract Maintenance form in a new window. Complete the form and click **Add**.

- Click the **Contract** link to view or edit a contract. This opens the Contract Maintenance form in a new window.

- Click the **Customer Number** link to view more customer information. This opens the Sage ERP Accpac A/R Customers form.

- Click the **Drill Down** icon to view a summary of a contract. This opens the Contract Summary form, which displays contract information, and a list of projects associated with the contract.
Using Sage ERP Accpac Inquiry

On the Contract Summary form, you can do the following:

- Click **Edit** in the right sidebar or the **Contract** link to view or edit the contract. This opens the Sage ERP Accpac Contract Maintenance form.

- Click the **Optional Fields** link (where available) to view the optional fields associated with the contract.

- Click the **Customer** link to view customer information.

To view more details about a project, click a link in the **Project** column to open the following screen:

Click the **Optional Fields** link (where available) to view the optional fields associated with the project. You can also click the **Contract** or **Customer** link to view contract or customer information.
The Project Detail form also lists transaction documents associated with the project.

To list only certain documents, specify filter criteria and click the **Filter** button. For example, to list only Accounts Receivable documents, select “A/R Only” in the **Applications** field.

You can view some documents, such as Accounts Receivable invoices, in a Sage ERP Accpac form. To view these documents, click any active link in the **Document Number** column.

To view a summary of a transaction, click the **Drill Down** button to open the following form:

On the Transaction Information form, you can click any link to view more details. For example, you can click the **Contract** or **Customer** links, or the **Document Number** link (if available).

**Viewing Contract Transaction History**

**To view contract transaction history:**

- On the P/M Inquiry tab, click **Transaction History**.
The Transaction History screen appears:

For a contract with projects that have been assigned multiple customers, you can view the transaction history of that contract or project for any of the associated customers.

You can do the following on this form:

- To display only transactions of your choice, specify filter criteria and click the **Filter** button. For example, to display only transactions which originated in Purchase Orders, select **P/O Only** in the **Application** field.

- Click a **Drill Down** icon for more information about a transaction. This opens the Transaction Information form.

- For more information about a contract, click the link in the **Contract** column to open the Contract Maintenance form in a new window.

- For more information about a document, click an active link in the **Document Number** column to open a Sage ERP Accpac form in a new window.

- For more information about a resource, click an active link in the **Resource** column.
Return Material Authorization (R/A) Inquiry

If you use Sage ERP Accpac Return Material Authorization (RMA), you can view or modify return authorization documents within the context of a company on the R/A Inquiry screen.

For a customer, the R/A Inquiry screen provides the following options:

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Return Authorizations</td>
<td>List of Return Authorizations.</td>
</tr>
</tbody>
</table>

**Note:** The R/A Inquiry screen does not provide the option to create a new return authorization for a vendor.

Creating a New Return Authorization

**To create a new return authorization:**

1. On the R/A Inquiry screen, click **New Return Authorization**.

   The Return Authorization form opens in a new window:

   ![Return Authorization Form](image)

   2. Complete the form and click Add.

   You can also create a return authorization from the screen that lists return authorizations.
Viewing or Editing Return Authorizations

To view or edit return authorizations:

- On the R/A Inquiry screen, click All Return Authorizations.

A list of return authorizations appears:

You can do the following on this form:

- To refine your list of displayed transactions, enter search criteria in the filter and click Filter in the right sidebar. For example:
  - To include completed transactions in the list, select Include Completed Transactions.
  - Display only the transactions that fall within the range of dates that you specify.

- Create a return authorization for a customer by clicking New on the right sidebar to open the Return Authorization form in a new window, completing the form, and clicking Add.

- Use a Sage ERP Accpac form to view or edit a return authorization by clicking the contract’s link in the All Return Authorizations column. This opens the Return Authorization form in a new window.

- Click the Drill Down icon to view a summary of a return authorization. This opens the Return Authorization Summary form, which displays the return authorization’s general information and detail lines.
On the Return Authorization Summary form, you can do the following:

- Click **Shipping & Billing Addresses** on the right sidebar to view shipping information.
- Click **Edit** on the right sidebar or the **RA Number** link to view or edit the return authorization.
- Click links in the Return Authorization Information section of the form to view more details about the customer or a document (such as the return authorization document, last customer order, customer credit note, or vendor return).
- Click the **Optional Fields** link (where available) to view optional fields for the return authorization.
- In the detail section of the form, click any links in the **Customer Original Invoice** column or **Vendor Original Receipt** column.
- In the details section of the form, click the link in the **Item Number** and **Location** columns to open a form that displays more item information, and the locations where the item can be found.

---

**Solo Integration with SageCRM**

The SageCRM Solo client enables you to work with SageCRM data offline and then synchronize that data with your SageCRM database. Solo integration enables you to view Sage ERP Accpac customers and vendors on the Solo client.

**Notes on Using Solo client with SageCRM**

- Integrated SageCRM screens and Sage ERP Accpac forms are only available online. You cannot access these screens and forms using the Solo client.
- You can only create and edit non-Accpac SageCRM data using the Solo client. If you attempt to create or edit Sage ERP Accpac data, an error message will appear.
- If a Sage ERP Accpac company does not have a contact, the company will not appear in the Solo client after synchronization.
- When you upgrade from a previous version of SageCRM that uses Solo, you must follow the instructions for upgrading in “Option 2” of the *SageCRM Solo Guide*. This involves uninstalling the old Solo client and installing the new one.
If you need to reinstall Sage ERP Accpac integration:
1. Reinstall Sage ERP Accpac integration.
2. Uninstall the Solo client (follow the steps in the SageCRM Solo Guide).
3. Restart the Solo workstation.
4. Recreate the snapshot on the server.
5. Reinstall the Solo client on the workstation.
6. Re-synchronize the data on the Solo client.

Now You Can...
- View and modify company and opportunity information in SageCRM.
- Import national accounts.
- Change customer and vendor numbers.
- Create and work with O/E quotes and orders.
- Use Sage ERP Accpac Inquiry features to view and edit documents and transactions.